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Measurements of snow accumulation are critical to studies of mass balance.
Traditional point measurement techniques (snow pits, manual probes, firn and ice
cores) are limited in space and often do not represent the region surrounding them due
to spatial variability that is caused by a variety of factors, including surface slope and
deposition and erosion by wind. Current accumulation maps of Greenland are based
on point measurements and have estimated errors of 20-25% (Bales et al., 2001;
Ohmura and Reeh, 1991). Ground-penetrating radar (GPR) has the potential to
significantly improve upon these accumulation estimates because of its ability to
cover large regions over short time periods with relative ease at high vertical (depth)
and horizontal (areal) resolutions. The current study employs GPR data to investigate
the distribution and variability of accumulation at shallow depths (~5 m) and at the
local scale (100-m by 100-m) at two locations on the Greenland ice sheet (Tunu-N
and NASA-U). Beyond providing a better understanding of local-scale snow
accumulation patterns on the Greenland ice sheet, the results that will be discussed
also have potential implications for the interpretation and selection of ice cores as
well as for space-borne remote sensing techniques aimed at deriving snow water
equivalent (SWE) from passive-microwave and/or scatterometry.
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1. Introduction

Due to the technical and physical difficulties involved, it is not known yet
whether the Greenland ice sheet is shrinking or growing. Net losses of ice mass,
potentially associated with climate change, are important to monitor because of the
commensurate rises in sea level, as well as freshening of the North Atlantic, which
could slow or halt ocean currents that transport heat to the north. Containing 8% of
all of the Earth’s fresh water, the Greenland ice sheet has the potential to raise the
global mean sea level by about seven meters if it were to melt. There is evidence that
Greenland significantly melted during the most recent interglacial (Cuffey and
Marshall, 2000) and may therefore be a primary contributor to sea level rise in the
event of continued global warming. This would be catastrophic for many coastal
regions across the planet (Small and Nicholls, 2003; Nicholls, 2002), inciting large
migrations of environmental refugees. On the other hand, a warmer atmosphere
could contain more water vapor, which may potentially lead to increased snow
accumulation and growth of the ice sheet (Zwally, 1989). Shutting down or
significantly weakening North Atlantic currents, furthermore, could abruptly halt heat
transport to the Arctic and incite another glacial period (Schwartz and Randall, 2003).
For all of these reasons, it is important to monitor Greenland’s mass balance, or
changes to its total volume of snow and ice.
Mass balance of the Greenland ice sheet can be estimated by measuring
volume inputs (snow accumulation) and subtracting volume losses (melting, iceberg
calving, and sublimation), by measuring changes in ice sheet height using altimetry
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and correcting for isostatic uplift and losses due to calving and basal melt of floating
ice tongues, or by measuring changes in the gravity field above Greenland and
correcting for isostatic uplift. Accurately measuring accumulation is critical to the
first method. Current estimates of snow accumulation on Greenland, however, have
large errors (20-25%) because they are derived from a relatively sparse network of
point measurements from snow pits, firn or ice cores, and manual probing (Ohmura
and Reeh, 1991; Bales et al., 2001). Ground-penetrating radar (GPR), also referred to
as radio echo sounding (RES) when used at lower frequencies (< 10 MHz), has the
potential to significantly improve upon these accumulation estimates because of its
ability to cover large regions over short time periods with relative ease at high vertical
(depth) and horizontal (areal) resolutions. This coverage is useful to help characterize
the spatial variability and distribution of accumulation.
A total of 20 automatic weather stations (AWS) have been installed across
Greenland since 1995 (Steffen and Box, 2001), known as the Greenland Climate
Network (GC-Net), as part of NASA’s Program for Arctic Regional Climate
Assessment (PARCA). The primary objective of this research has been to process
and analyze GPR data collected near two of these AWSs to analyze the variability
and spatial distribution of snow accumulation at the local scale (< 100 m). On May
31 and June 1, 2003, Dr. Steffen and his graduate student, Russell Huff, collected
100-m by 100-m GPR survey grids in the accumulation zone of Greenland near two
PARCA automatic weather stations: respectively, Tunu-N in the northeast (78°01’01″
N, 33°58′54″ W; 2113 m a.s.l.) and NASA-U in west-central Greenland (73°50′29″
N, 49°30′14″ W; 2369 m a.s.l.) (Figure 1).
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Figure 1. Map of the Greenland Climate Network (GC-Net), with Tunu-N
(northeast) and NASA-U (west-central) labeled.
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In this introduction I will review current knowledge about accumulation on
the Greenland ice sheet as well as previously published cryospheric applications of
GPR, focusing on those investigating snow accumulation. A more theoretical review
of the physics behind GPR over snow and ice follows, with emphasis on some of the
difficulties encountered when analyzing GPR data.

1.1. Current Knowledge About Accumulation On Greenland

Current estimates of snow accumulation on Greenland have large errors (2025%) because they are derived from a relatively sparse network of point
measurements from snow pits, firn or ice cores, and manual probing. These
measurements are sparse both temporally and spatially due to the difficulty of
collecting measurements in the harsh environment of the Greenland ice sheet and
because they are manually intensive to acquire. The most recent compilations of
existing accumulation measurements are Ohmura and Reeh (1991) and Bales et al.
(2001). In total, the number of point locations included in these compilations are 251
and 256, respectively, spread over more than three-quarters of a century from 1913 to
1999.
The mean accumulation maps derived in these two sources agree to within 3%
of their total accumulation average for the entire ice sheet (31 g·cm-2·yr-1 vs. 30 g·cm2

·yr-1) but have large regional differences due to differing interpolation techniques

(hand-contouring in Ohmura and Reeh, 1991, vs. kriging in Bales et al., 2001) and
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data sources. Overall, the Bales et al. (2001) map (Figure 2) is an improvement on
the previous Ohmura and Reeh (1991) compilation due to the addition of new, highquality firn and ice cores from NASA’s PARCA initiative and their filtering out of
erroneous, short (single-year), and/or closely spaced records. There are relatively few
data records below 1800 m elevation or in northeastern, southeastern, far northern, or
east-central Greenland.
Primary sources for spatial distribution of accumulation on the ice sheet
include topography and wind/atmospheric circulation patterns (Ohmura and Reeh,
1991; van der Veen et al., 2001). The greatest accumulation on the ice sheet occurs
in the southeast due to cyclonic activity generated by the Icelandic low in winter,
while the least accumulation occurs in the northeast due to the precipitation shadow
that is caused by a topographic barrier preventing flows from both the southeast and
the west. The west coast of Greenland experiences moderate accumulation from a
wet continental air mass in the summer but is mostly dry in the winter except for stray
cyclones entering Baffin Bay through Davis Strait from the Atlantic. Meanwhile, the
northwest gets moderate-to-low levels of precipitation resulting from polar lows in
the summer only.
Based on the available measurements in the Bales et al. (2001) compilation,
the mean uncertainty (standard deviation) in accumulation on the Greenland ice sheet
is 24% (7 g·cm-2·yr-1) and ranges between 15-30% (4.5 − 9 g·cm-2·yr-1). In his effort
to produce formal error bars for Greenland’s existing accumulation maps, Cogley
(2004) notes the need to double our current accuracy in accumulation in order to
achieve a corresponding ±1 mm·yr-1 accuracy in sea level rise with 95% confidence.
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Figure 2. Map of observed mean annual accumulation on the Greenland ice sheet
from a collection of 256 snow pits and ice cores and 17 coastal meteorological
stations from the period 1913-1999 (Bales et al., 2001) reprinted from the Journal of
Geophysical Research with permission of the American Geophysical Union. Average
accumulation for the entire ice sheet is ~30 g·cm-2·yr-1 (300 mm·yr-1).
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He concludes that this can be achieved through measurement of the winter balance in
the ablation zone of Greenland, where measurements are currently extremely sparse,
and through concerted efforts involving airborne and spaceborne remote sensing
techniques. High-resolution airborne radar surveys seem like a promising avenue for
accomplishing this in the relatively near future (Kanagaratnam et al., 2001). It is
important to note, however, that uncertainty in the accumulation is only part of the
problem regarding accuracy of Greenland’s mass balance, and that the amount of
iceberg calving from the ice sheet may have an even larger uncertainty at this time.
Mosley-Thompson et al. (2001) point out that any single point measurement
of accumulation contains both a climate signal (i.e. accumulation due to climate in
that specific location) and local glaciological “noise” such as topography (e.g. smallscale sastrugi vs. large-scale shifting dunes) or redeposition and sublimation of snow
due to wind. In order to derive the climate signal, one must first correct for local
glaciological noise by using time-averaging within a point measurement (i.e. depthaveraging) and/or spatial-averaging across several closely-spaced point
measurements. How much averaging that is required for any particular location,
however, (i.e. how many years or points you must average across to separate out the
climate signal from the noise) is dependent on the degree to which local glaciological
noise impacts the snow accumulation at a given location.
Quantifying glaciological noise at the local scale at two locations in
Greenland is the objective of this thesis. Mosley-Thompson et al. (2001) drives home
the point for why this is an important endeavor: so that we can get a better
measurement of actual climate variability. Though closely-spaced cores have been
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compared for accumulation variability on the Greenland ice sheet (e.g. Humbolt >
20% within 25 km (Mosley-Thompson et al., 2001)), smaller-scale variability has not
been previously studied for the Greenland ice sheet. Such an assessment can best be
accomplished with GPR due to its continuous areal coverage.
Besides point measurements, other tools have also been used to measure
accumulation on the Greenland ice sheet, including remote sensing, meteorological
models, and GCMs. Drinkwater et al. (2001) use scatterometry measurements from
Seasat, ERS-1/2, NASA scatterometer (NSCAT), and QuikSCAT to empirically
relate the backscatter coefficient to accumulation in the dry snow zone of Greenland;
similarly, Nghiem et al. (2005) use QuikSCAT to derive accumulation in the
percolation zone of Greenland. As previously mentioned, high-resolution airborne
radar also shows promise in mapping accumulation over the entire ice sheet
(Kanagaratnam et al., 2004). Meteorological models have been used to employ
ECMWF re-analysis data (ERA-40) for the analysis of ice sheet-wide mass balance
and accumulation patterns for the period 1958-2003 (Hanna et al., 2005). GCMs do
not yet accurately reproduce mean accumulation on Greenland, consistently
underestimating this value. Nevertheless, ECHAM4 and Genesis-2 have been used to
predict a ~30% increase in accumulation for Greenland in a double-C02 climate due
to increased moisture in the atmosphere and northward displacement of the Icelandic
low, which brings precipitation to southeastern Greenland (Wild and Ohmura, 2000;
Thompson and Pollard, 1997). The magnitude of such predictions justifies the need
for a better understanding of accumulation changes in Greenland, to which the current
study hopes to contribute.
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1.2. Cryospheric Applications of GPR

Since the first surface-based radar soundings of ice in 1964 (Walford, 1964),
glaciological applications of GPR have included measurements of glacier or ice sheet
thickness (e.g. Welch et al., 1998), basal conditions (e.g. Winebrenner et al., 2003),
liquid water content (e.g. Arcone, 1996; Albert et al., 1999; Pettersson et al., 2004),
and internal structure (e.g. Pälli et al, 2003), including crevasse and buried debris
detection for the purposes of construction (e.g. Delaney and Arcone, 1995; Delaney et
al., 1999). In the category of internal structure, GPR surveys have been successfully
conducted to identify isochronous reflection horizons for correlating between
disparate ice cores in order to better calibrate their time-depth relationships (e.g.
Eisen et al., 2003a). Internal reflection horizons have also been used to infer glacial
dynamics (e.g. Vaughan et al., 1999) and, more relevant to the current study, patterns
of snow accumulation over time and space. Other cryospheric applications of GPR
include mapping of permafrost extent and depth (e.g. Wu et al., 2005; Judge et al.,
1991) as well as measurements of snow depth and snow water equivalent (SWE) in
alpine mountain catchments (e.g. Marchand et al., 2001; Marchand and Killingveit,
2004) and validation of spaceborne radar data (e.g. Engeset and Ødegård, 1999).
To date, there have been several published studies using GPR to measure
snow accumulation distribution and variability. These have focused on glaciers and
ice caps on Svalbard and on a few locations on the Antarctic ice sheet, which I will
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briefly review here. Though there have been numerous airborne radar studies of the
Greenland ice sheet, no GPR studies conducted on Greenland appear in the scientific
literature.

Svalbard:

Winther et al. (1998) conducted three GPR transects ranging in length from
approximately 100-200 km on Spitsbergen, Svalbard in May, 1997 at 450 & 500
MHz. The previous year’s snow accumulation was mapped, using manual probing
and snow pit stratigraphy for validation, and converted to snow water equivalent
using representative in situ measurements of density. They found that accumulation
increases significantly with elevation, is 38-49% higher in the east than the west, 4055% higher in the south than the north, and occurs at a minimum in central and
northern locations.
Pinglot et al. (2001) similarly mapped the previous year’s snow accumulation
on the Austfonna ice cap on the nearby island of Nordaustlandet, Svalbard in
1998/1999 at 500 MHz measured across seven separate 300-km transects. As Winther
et al. (1998) found on Spitsbergen, Pinglot et al. find that accumulation increases
with elevation and is higher on the eastern coast compared with the west. Of
particular interest was their finding that SWE is highly variable over both short (50100 m) and long (1-10 km) distances, with up to 25% variability in the accumulation
zone of the ice cap, presumably due to wind scouring and redeposition of snow. The
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authors conclude that individual measurements (cores and pits) are therefore not a
reliable estimator of average accumulation rates.
Pälli et al. (2002) limited their GPR survey to Nordenskjöldbreen glacier on
Spitsbergen, Svalbard in May, 1999 over a single 11.4 km transect. Using a much
lower frequency of 50 MHz to achieve greater penetration depths, the authors use
data from three existing ice cores along the transect to accurately date two
accumulation layers identified in the GPR data at depths of roughly 10 m (1986) and
20 m (1963). They then use the GPR data to measure and compare snow
accumulation rates between three time periods, finding an average annual
accumulation rate for 1986-1999 that is 12% higher than for the period 1963-1986.
Of interest to my study is that they also found high spatial variability (40-60%) in
snow accumulation over short distances (100 m) along their transect, which they
attribute, in part, to changes in basal topography beneath the glacier (i.e. increased ice
thickness within bedrock depressions).
Lastly, Sand et al. (2003) acquired 13 transects on Spitsbergen and
Nordaustlandet, Svalbard during 1997-1999 at 450 & 500 MHz, ranging in length
from approximately 100-200 km at four different latitudes. Methodology and results
were similar to Winther et al. (1998) and Pinglot et al. (2001) for mapping the
previous year’s snow accumulation. The authors also note that accumulation varies
considerably on the Austfonna ice cap over relatively short distances (a factor of four
within a few tens of kilometers) due to topography.

Antarctica:
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Richardson et al. (1997) use frequency-modulated continuous wave (FMCW)
GPR at a center frequency of 1550 MHz and a bandwidth of 800-2300 MHz to
measure accumulation variability on Dronning Maud Land, East Antarctica during
the austral summer of 1993/1994. Penetrating 12 m below the surface, their 1040 km
transect extended from the ice shelf of the Antarctic coast at Neumayer station inland
to the polar plateau. The authors find that accumulation is highly variable over short
and regional distances: over a distance of < 5 km, accumulation varied by as much as
± 60-70% from the local average value. Areas with large surface slopes reached
standard deviations of 59% from the spatial average accumulation, while smoother
areas on the higher-altitude plateau had standard deviations reaching 22%. The
authors conclude that wind redistribution due to topographic features may have a
major influence on the observed variability and that because of the large magnitude of
variability in the region, point measurements are insufficient for characterizing
accumulation.
Richardson and Holmlund (1999) similarly measure accumulation variability
at Dronning Maud Land, East Antarctica, in 1996/1997, using 800-2300 MHz
FMCW. They conducted a 500-km traverse on the polar plateau along a path of 11
existing firn cores. The GPR transect shows that the firn cores are generally
representative of the mean accumulation rate of the surrounding region, but can be off
by as much as 22%, indicating the importance of incorporating GPR for the validation
and interpretation of firn and ice cores. The GPR data also show standard deviations
in depth of accumulation layers ranging from 3-35%, with less variability (< 10 %) at
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higher elevations on the plateau where the surface relief is much smoother. The
authors also conducted a more detailed GPR survey (700-1100 MHz, 15 km x 20 km)
surrounding a deeper core (100 m) nearer the coast. For this study, they found that the
spatial variability in accumulation was 21% and that the core underestimates the
mean accumulation rate for the survey grid area by 10% (Figure 3).

Figure 3. Example of local-scale snow accumulation variability mapped from GPR
data, as measured in East Antarctica in 1999 (Richardson and Holmlund, 1999).
Frezzotti et al. (2004) acquired a 1000+ km GPR transect extending from
Terra Nova Bay to Dome C in East Antarctica during a 1998-2000 investigation.
Their study shows that accumulation is homogenous at large scales (> 100’s km2) but
highly variable (3-47% std. dev.) at short (10’s of m) and medium (km) spatial scales
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due mostly to wind-driven processes. They also conclude that previous compilations
of surface mass balance (SMB) in the study region, which are based on point
measurements, over-estimate SMB by as much as 65% due to sparse data and the
unrepresentativeness of many of the collected data points as compared with their GPR
results.
Lastly, King et al. (2004) collected a 100-MHz 13-km transect across the
Lyddan ice rise in northwestern Antarctica (74º S, 22º W) off the coast of the Weddell
Sea during 2000-2002, with a penetration depth ranging from 5-50 m. Counter to
previous assumptions, they found that even gentle topography (slopes < 0.04) can be
associated with large spatial variability (20-30%) in snow accumulation. Based on
wind speed measurements from nearby automatic weather stations and radiosonde
measurements as well as a snow transport model using these data, they were able to
attribute the observed variability in accumulation to postdepositional redistribution
(i.e. sublimation and redistribution of wind-borne snow). Similar to the other
publications described above, the authors therefore caution that the interpretation and
location of ice cores must be done carefully to avoid wind-driven variation patterns
that may mask or distort the climate-based precipitation variability derived from such
data.

In summary, almost all of the aforementioned GPR publications report high
spatial variability in snow accumulation over both short and regional scales due to
either surface and/or basal topography and the wind patterns that surface topography
controls, even on surfaces with very gradual slopes. The authors therefore
recommend caution in the interpretation of point measurements when used to
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represent average accumulation over a surrounding area. None of the studies are at
the scale or location used in my thesis, which investigates sub-100-m accumulation
variability at two locations on the Greenland ice sheet, so it will be interesting to find
out how our results compare against these previous GPR surveys.
Other reviews of cryospheric GPR applications include Plewes and Hubbard
(2001) and Gruber and Ludwig (1996). Siegert (1999) also presents a review of
airborne radar surveys conducted in Antarctica that is also relevant to the current
investigation.

1.3. The Physical Basis of GPR

Short, successive pulses of radar electromagnetic energy are transmitted by a
GPR antenna. These radar pulses are reflected at dielectric discontinuities (Figure 4).
The reflected pulses are measured by a separate receiver antenna and result in
relatively high amplitude signals in the output display at the location of the
discontinuity. Discontinuities in snow and ice include air-bubble related changes in
density, liquid water content, chemical impurities, and crystal fabric (Pälli et al.,
2002). In dry snow in the uppermost ~75 meters, changes in density have the most
significant impact on the radar signal (Winther et al., 1998).
Depositional processes of snow accumulation create stratigraphic layers
within the subsurface. Melting and refreezing of snow at the end of summer results in
relatively dense layers of snow and/or hoar frost that appear in GPR data as reflection
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Figure 4. Radar pulses are reflected at dielectric discontinuities (Plewes and
Hubbard, 2001).
horizons (Figure 5). These layers are shaped by spatial variation in accumulation,
surface slopes, and wind-induced snow deposition and erosion. The data for this
project were collected over flat terrain, however, so surface slope does not play a
significant role. Intrusions of refrozen melt water that exist as ice layers and ice
lenses within the subsurface, prevalent in the percolation zone of Greenland, may
interrupt the continuity of these stratigraphic layers and result in gaps in the GPR
reflection horizons.
GPR instruments measure the time it takes for a pulse to travel to and from a
target, referred to as its two-way travel time (TWT). In order to convert this travel
time into a measurement of depth, the velocity of the radar pulse through the
subsurface must be known (i.e. depth [m] = velocity [m/s] * time [s]). Velocity is a
function of two electrical properties of the propagated medium: its relative dielectric
permittivity (εr) and electrical conductivity (σ), collectively referred to as the
“dielectric constant.” A material’s dielectric permittivity measures its capacity to
store an applied electric charge relative to a vacuum, thereby impeding its flow. A
material with high εr, such as liquid water, absorbs an applied electromagnetic signal
such as GPR such that very little signal is left to be reflected to the instrument.
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Figure 5. Sample GPR profile from Tunu-N, Greenland, illustrating reflection
horizons.
Electrical conductivity, on the other hand, measures the ability of a material to
conduct, or carry, an applied electrical charge. A material with high σ, such as a
metal, acts as a good conduit for a GPR signal, carrying most of the signal away from
the instrument into the host material so that very little signal is reflected to the
instrument. For these reasons, GPR requires subsurfaces with low enough εr and σ so
that the signal is not completely absorbed.
The conductivity of pure snow and ice is almost zero so that velocity is
primarily determined by the relative dielectric permittivity of the subsurface, which
varies between ~1.0 for air and ~3-4 for ice, with intermediate values for snow and
firn (i.e. compacted snow) depending on density (Plewes and Hubbard, 2001).
Density profiles can be measured, then, using ice core dielectric profiling (DEP)
(Eisen et al., 2003b) or traditional stratigraphic methods associated with snow pits
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and cores (Østrem and Bruggman, 1991) for deriving a velocity-depth function that
can be applied to the GPR data for converting TWT to measurements of depth.
Velocity can be empirically related to density via the permittivity of snow (Mätzler,
1996). The resulting permittivity can then be used to compute the velocity of the
radar signal through the snow via the following equation:

v = c / √εr

where: v = wave propagation speed,
c = speed of light in a vacuum (0.3 m/ns),
εr = relative dielectric permittivity.
Once the depth of a given reflection horizon is known, accumulation above
that horizon can be derived. For the purposes of our data, calibration of TWT to
depth is accomplished using an average snow density measured from a snow pit at
one corner of the GPR survey grid.
Advantages of using GPR include its complete areal coverage, ease of use
relative to traditional point measurement techniques, and high resolution. There are
also difficulties associated with using GPR, however, which I expound upon here:

Antenna ringing. Horizontal banding in the resulting radargram is caused by
"ringing" of the radar signal (negative and positive perturbations of signal strength)
that results from interference due to radar waves that flow directly from the
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Figure 6. An illustration demonstrating antenna ringing (left) and a sample
GPR profile demonstrating the horizontal banding that results from this (right).
transmitting antenna and couple with the signal received at the receiving antenna
during data acquisition (Figure 6).
Near-field effect. GPR does not collect good data near the surface down to a
depth of about 1.5 times the center wavelength (the “near-field effect”; Conyers and
Goodman, 1997) while the signal first penetrates the surface from the air above it and
is still in the process of coupling with the subsurface medium (Figure 7).

Figure 7. An illustration demonstrating the near-field effect (left) and a
sample GPR profile demonstrating the extreme horizontal banding that results from
this at the top of the profile (right).
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Geometrical spreading. Because of geometrical spreading, the radar signal
decreases exponentially in strength with depth as 1/r2, where r is depth (Plewes and
Hubbard, 2001) (Figure 8).

Figure 8. An illustration demonstrating geometrical spreading (left) and a
sample GPR profile demonstrating the loss of signal with depth that results from this
(right).
Echoes. There is often evidence of multiple reflections (i.e. echoes) from a
single reflection horizon in the resulting radargram when part of the return signal
continually bounces between the surface boundary and the reflection horizon (Figure
9). With each subsequent “bounce,” however, the signal dissipates in energy so that
subsequent echoes become increasingly faint in the resulting GPR data. The brightest
return in the radargram, therefore, can be interpreted as the first reflection and the true
source of the reflector in the subsurface.
Interpretation. Because dielectric discontinuities can be due to a variety of
factors, the interpretation of GPR data can sometimes be challenging, in cryospheric
applications as well as in others. Reflection horizons in glacial subsurfaces can be
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Figure 9. An illustration demonstrating radar echoes (left) and a sample GPR
profile demonstrating the repeated layers that result from this (right), highlighting one
particular layer in red.
due to accumulation layers, sporadic ice lenses from refrozen meltwater, layers of
meltwater, relatively dense snow resulting from past weather events, crevasses,
debris, dust layers, etc. At lower resolutions, also, the reflections that are apparent in
the radargram are a combined effect of dielectric properties within the subsurface
since individual layers cannot be resolved, making the data interpretation all the more
complex. For these reasons, it is important to include in situ observations (e.g. snow
pit stratigraphy, historical AWS measurements, manual probes, firn/ice cores, etc.)
along with a GPR survey to help identify features and interpret the resulting
radargram.
Resolution vs. penetration depth. Shorter wavelengths can resolve smaller
features within the subsurface but dissipate more quickly with depth as they are
readily absorbed by the medium. Longer wavelengths can penetrate more deeply into
the subsurface but have poorer resolution in the vertical (depth) direction. As a
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practical sidenote, longer wavelengths also require larger antennae and more
sophisticated transport mechanisms.
Resolution vs. noise. The tradeoff to good resolution is a higher incidence of
noise, or a lower signal-to-noise ratio, which speckles the resulting radargram and can
heavily obscure features you are trying to locate.
Correct for topography. GPR data that are not collected over flat terrain
must correct for surface topography by warping the data in the vertical direction so
that reflection horizons are not distorted (Figure 10). This requires the collection of
accurate GPS elevation data coincident with the GPR survey.

Figure 10. An illustration demonstrating the effect of topography on the
resulting radargram if left uncorrected. The top two scenarios properly reproduce the
shape of the subsurface reflection horizon, but the bottom scenario skews the horizon.
Correct for forward velocity variations. GPR data must also be
dynamically stretched or compressed in the horizontal direction after data collection
to correct for any significant variation in forward velocity of the antennae during data
acquisition, if any. This either requires GPS data or equidistant markings stored
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within the data via an attached wheel during acquisition. Because such wheels do not
often operate successfully over snow and ice surfaces, the GPS method is usually
used.
TWT-depth conversion. As previously mentioned, consideration and effort
must be made prior to a GPR survey for calibrating the instrument’s native
measurement of two-way travel-time (TWT) to a more useful measurement of depth.
This can be acquired in a variety of ways of varying accuracy, from dielectric
profiling of the subsurface, to calibration against a target of known depth, to manual
measurements of density in a snow pit.

The GPR data processed and analyzed for this thesis exhibit a number of the
difficulties mentioned above. At a frequency of 1000 MHz, our data have high
enough depth resolution (~0.5 cm ) to resolve individual stratigraphic layers. On the
downside, they only penetrate about five meters into the subsurface before
geometrical spreading completely dissipates the signal, and they also have a relatively
high incidence of speckle (noise). Antenna ringing is obvious in the horizontal
banding that is present throughout the data, and the near-field effect highly distorts
the imagery down to a depth of roughly 45 cm. Echoes from stratigraphic layers are
numerous and can be tricky to separate visually in areas where overlap of echoes
from different layers occurs. Interpretation of the subsurface features in the
radargram has been aided by snow-pit stratigraphy and AWS sonic surface-height
measurements. Because the surveys were conducted over flat terrain and at constant
walking speed, it was unnecessary to correct for vertical or horizontal distortion
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within the data. Lastly, TWT-depth conversion has been made by a simple average
density derived from the snow pit analysis.
In short, as I will show later, the data allow successful identification of 1-2
stratigraphic layers after processing to correct for antenna ringing, the near-field
interference zone, geometrical spreading, and noise. Echoes and remaining noise
make the layer identifications difficult along some areas of the survey grid but not
impossible. From these layers, variability and distribution of snow accumulation
have been computed for two 100-m by 100-m GPR survey grids in northeastern and
west-central Greenland.

1.4. Project Significance

The proposed GPR study is one small piece in the larger puzzle of
Greenland’s mass balance. With the potential to raise sea levels by as much as seven
meters if it were to completely melt, it is imperative that Greenland’s mass balance be
better understood and monitored. Though continued global warming is not expected
to melt the ice sheet entirely or very quickly, Greenland’s contributions to sea level
rise could still be significant. Melt can also indirectly influence ablation through
basal lubrication and increased dynamic response of the ice sheet, leading to greater
rates of calving (Zwally et al., 2002). Although Greenland is an order of magnitude
smaller than Antarctica, it has a much greater potential for melting due to its lower
latitude, and there is evidence that it has significantly melted in the past during the
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most recent interglacial (Cuffey and Marshall, 2000). Losses in Greenland’s mass
balance could also combine with other increasing outlets of freshwater into the Artic
(melting glaciers and permafrost, increased precipitation) that may eventually slow or
halt the oceanic conveyor belt that transports heat to the Arctic, with the potential for
abrupt climate change that could catapult the planet into another glacial period
(Schwartz and Randall, 2003). Because global warming is amplified in the Arctic
due to positive feedbacks associated with the high albedo of snow and ice, it is
imperative that we continue to monitor and improve our understanding of
Greenland’s mass balance.

2. Methods

2.1. Data Acquisition

A total of 20 automatic weather stations (AWS) have been installed across
Greenland since 1995 (Steffen and Box, 2001), known as the Greenland Climate
Network (GC-Net), as part of NASA’s Program for Arctic Regional Climate
Assessment (PARCA). On May 31 and June 1, 2003, Konrad Steffen and Russell
Huff collected GPR data in the accumulation zone of Greenland near two PARCA
AWSs: respectively, Tunu-N in the northeast (78°01’01″N, 33°58′54″W; 2,113 m
a.s.l.) and NASA-U in west-central Greenland (73°50′29″N, 49°30′14″W; 2,369 m
a.s.l.).
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The Tunu-N location experiences relatively little accumulation (Ohmura and
Reeh, 1991; Bales et al., 2001) or melt (Abdalati and Steffen, 2001) throughout the
year, with 100-150 mm·yr-1 of snow water equivalent (SWE) accumulation on
average (Bales et al., 2001). In 2002, however, Greenland experienced an
anomalously large amount of surface melt that extended from the northeast coast into
the region where Tunu-N is located (Steffen and Huff, 2003). This melt event, after
refreezing as an ice layer in the subsurface, results in a dielectric contrast compared to
the snow above and below it that appears as a distinct reflection horizon within the
GPR data and will be analyzed as part of this project. The NASA-U location
accumulates twice as much snow annually as Tunu-N with 200-300 mm·yr-1 SWE on
average (Ohmura and Reeh, 1991; Bales et al., 2001) and regular occurrence of
summer melt (Abdalati and Steffen, 2001), providing two visible reflection horizons
in the collected data.
Besides refrozen melt layers and summer accumulation surfaces that appear
via hoar frost, other mechanisms that can cause reflection horizons through the
formation of dielectric interfaces in the subsurface are: relatively dense layers that
form through wind compaction (wind crusts); percolation and refreezing of melt
water as discontinuous ice layers, ice lenses, and ice pipes; layers that may have
formed as the result of significant dust deposition; as well as the presence of
crevasses or other empty spaces in the subsurface.
A Malå Geoscience (http://malags.com) RAMAC™ GPR instrument with a
1000-MHz antenna (the highest frequency antenna offered for the RAMAC GPR)
was housed and pulled in a sled at a constant walking speed for the GPR surveys.

27
Sixteen consecutive traces were stacked together during data acquisition to reduce
noise in the horizontal (areal) direction. The instrument transmitted pulses at a rate of
24,081 MHz, collecting 1024 discrete samples per trace over a two-way time window
of 42.5 ns. The data therefore have high vertical (depth) resolution of ~0.5 cm, well
within the width of many stratigraphic layers. Using an average dry snow density of
0.3 g·cm-3 measured at each of the snow pits and an empirically derived relative
dielectric permittivity of 1.62 (Mätzler, 1996), maximum penetration depth of the
GPR signal at 1000-MHz over a 42.5 ns two-way time window was about five
meters. Within these five meters, one or two stratigraphic layers can be visually
identified within the data after filtering.
Non-differential GPS data were collected coincident with the GPR data. Due
to the low position update rate of many GPS receivers (one measurement per second,
in our case), the RAMAC acquisition software interpolates between GPS positions so
that each individual GPR trace has an assigned GPS position. Though differential
GPS data were also collected during the survey, the low number of available GPS
satellites at the time of collection prevented improved accuracy. Though the nondifferential GPS data give relatively poor estimates of surface elevation, the surface
was very flat and so the elevation measurements are ignored. Accuracy in latitude and
longitude, however, appears to be more than sufficient at the scale of the current
study.
Surveys were conducted along 100-m by 100-m grids, with 10-m spacing
between transects (Figure 11). In addition, two diagonal transects were collected,
connecting opposite corners of the grid, providing overlap with other measurements
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to allow for subsequent validation. A shallow snow-pit (2-3 meters) was dug at one
corner of each grid to investigate stratigraphic layers and their depths to assist in
subsequent analysis of the GPR data.

snow pit

10 m

10 m
100 m
Figure 11. Survey grid used for both the Tunu-N and NASA-U GPR surveys.

2.2. Data Processing

•

For step-by-step data processing instructions, please see the instruction
manual provided in Appendix A. For a listing of the custom IDL programs
written for this project, please see Appendix B, which also includes
documentation and installation instructions for these programs.
Preprocessing of the resulting GPR data is necessary to produce quality

images with clearly-visible reflection horizons. Malå Geoscience “GroundVision”
software, used to acquire and display GPR data from the RAMAC instrument, has
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filtering capabilities that can dramatically improve the appearance of data when
properly applied. Unfortunately, however, these filters are for display purposes only
and cannot be permanently applied to the data or saved to a new output file,
preventing any post-processing on the filtered data such as digitizing reflection
horizons in other image-processing applications. To circumvent this limitation, we
have simulated the GroundVision filters based on their description in the manual into
a programming environment that allows us to save the results for subsequent
processing and data analysis. This has been accomplished using Research Systems
Inc.’s (RSI) (http://rsinc.com) Interactive Data Language (IDL) programming
language along with RSI’s Environment for Visualizing Images (ENVI) imageprocessing software. A histogram-based image contrast stretch is automatically
applied in ENVI to enhance details. In addition, the following IDL/ENVI software
tools have been created:

1. Subtract Mean Trace

Removes horizontal banding within the radargram by subtracting a calculated
mean trace from all traces. A "trace" is a single, vertical column of GPR data,
representing the signal "traced" by radar pulses as they travel from the
instrument into the subsurface and back. Horizontal banding is caused by
"ringing" of the radar signal (negative and positive perturbations of signal
strength) that results from interference between the transmitting and receiving
signals since some of the transmission travels straight from the transmitter to
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the nearby receiver antenna (i.e. the “direct wave”) (Figure 6).

2. Time- (Depth-) Varying Gain

Because of geometrical spreading, the radar signal decreases in strength with
depth as 1/r2, where r is depth (Plewes and Hubbard, 2001) (Figure 8). Each
radar trace is multiplied by a gain function combining linear and exponential
components, with coefficients set by the user, to correct for this loss of signal
with depth.

3. DC Removal

There is often a constant offset in the amplitude of each radar trace caused by
interference from direct current (DC) used to power the GPR instrument. This
filter removes the DC component from the data, which has the effect of
making the data less noisy.

Because of the extremely flat surface terrain (Figure 12) and constant walking
speed of the GPR survey, there was no need to also correct for vertical (topography)
(Figure 10) or horizontal (areal) variations that would otherwise distort the data.
The original data file was spatially subsetted into individual 100-m or 10-m
transects in order to decrease the individual file sizes to improve processing speed
and filter performance. After application of the above filters, the GPR data are
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a) Tunu-N AWS, 31 May 2003

b) NASA-U AWS, 1 June 2003

Figure 12. Photographs of the Tunu-N (a) and NASA-U (b) AWS at the time of the
GPR surveys. Note the very flat topography at these sites. The disturbed region
directly surrounding the Tunu-N AWS is the result of human footprints.
visually optimized for identifying reflection horizons, as shown in Figure 13 below.
Now that the reflection horizons can be visually identified, the next step is to
digitize these reflection horizons so that the stratigraphic layers can be compiled,
visualized, and analyzed. Because the reflection horizons are not continuous enough,
display multiple echoes, are distorted by varying degrees of noise, and are not
delineated clearly enough for automatic or semi-automatic identification, this process
was done manually using ENVI’s polyline Region of Interest (ROI) tool, which
allowed the layers to be traced with the mouse, capturing the location of every pixel
therein for subsequent analysis (e.g. see red line in Figure 13).
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Figure 13. Screen shot in ENVI showing GPR data before (left) and after (right)
application of custom-made IDL filters listed in the pull-down menu. Note the
clearer reflection horizons and lack of horizontal bands (ringing) in the right image. A
stratigraphic layer has been traced in the right image in red.
After a contiguous layer had been digitized for the entire GPR survey grid, the
depth and location (latitude and longitude) of each point in the layer could be
extracted. Depth was computed using the two-way travel time window (i.e. the total
time in nanoseconds that the instrument was set to “listen” for radar pulses during
acquisition) and an estimated radar velocity (i.e. the velocity with which radar pulses
traveled through the subsurface). Using an average dry snow density of 0.3 g·cm-3
measured at each of the snow pits and an empirically derived relative dielectric
permittivity of 1.62 (Mätzler, 1996), radar velocity was computed to be 236 m·µs-1
according to the previously described equation:
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csnow = cvacuum / √ε’

where csnow is the computed radar velocity in snow, cvaccum is the speed of light in a
vacuum (300 m·µs-1), and ε’ is the relative dielectric permittivity of the subsurface
(snow = 1.62).
After compiling latitude, longitude, and depth for each point in a stratigraphic
layer, the output was fed into Surfer software, version 8.00, by Golden Software, Inc.
(http://www.goldensoftware.com) for applying kriging to grid the data and render a
smooth three-dimensional surface for visualization purposes.

2.3. Data Analysis

The first step of analysis was to validate the GPR measurements. This was
accomplished in a variety of ways. Observed stratigraphy of the subsurface in a
shallow snow pit at one corner of the GPR surveys is compared against depth of
layers detected in the GPR data. Also, points within the GPR survey where transects
overlapped (i.e. cross-points) are used to test how well measurements of depth are
reproduced. Lastly, the directionality of patterns observed in the final threedimensional visualization is compared against the predominant wind direction
observed at the two sites as measured over several years by a nearby AWS.
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The spatial variability in the depth of stratigraphic layers is statistically
determined from the survey grid (not the kriged three-dimensional surface, since this
introduces interpolation errors) using the mean and standard deviation.
Lastly, the volume of snow measured above and between the separate
stratigraphic layers can be used to derive a measurement of snow accumulation in
terms of its snow water equivalent (SWE). In order to do this, the mean depth (cm) of
the layer is multiplied by the average snow density (0.3 g·cm-3), divided by the
density of water (1 g·cm-3), and then multiplied by 10 in order to derive SWE in units
of mm·yr-1.
All together, these measurements will provide an estimate as to how
(un)representative a single point measurement of layer depth using traditional mass
balance techniques would have been for the surveyed grids. For one such comparison
at Tunu-N, the annual accumulation measured at the nearby AWS is compared
against the mean of the survey grid for a corresponding year.

3. Results

After filtering, only one internal reflecting horizon was clearly identifiable
within the Tunu-N GPR data while two separate horizons were identifiable in the data
for NASA-U. The results of applying kriging in the Surfer software package to these
digitized layers for visualizing them as three-dimensional surfaces is shown in Figure
14, where latitude and longitude are displayed on the X and Y axes, respectively, and
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a)

b)

c)

d)

e)

f)

Figure 14. Kriged three-dimensional surface views of stratigraphic layers identified
within the GPR data at Tunu-N (a-b) and NASA-U (layer 1: c-d, layer 2: e-f). Grid
surveys are 100-m by 100-m, and are outlined in the NASA-U data with a dashed
line, whereas the survey fills the entire images in the Tunu-N data. Images in the left-
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hand column (a, c, e) are orthogonal views looking straight down onto the surface,
with the predominant wind direction labeled from Steffen and Box (2001). Images in
the right-hand column (b, d, f) have 10x vertical exaggeration in the depth direction to
emphasize topography.
depth is shown on the vertical (Z) axis. Recall that the survey grids are 100-m by
100-m. Depth is plotted with 10x vertical exaggeration in the right-hand column to
emphasize the topography of the layers, since the layers are otherwise extremely flat
when plotted at true scale. These surfaces are also plotted orthogonally in the lefthand column of Figure 14 to help illustrate any spatial patterns.
The results of the three-dimensional surfaces plotted in Figure 14 were
verified using various other interpolation methods (e.g. nearest neighbor, natural
neighbor, triangulation with linear interpolation, etc.), each of which produced similar
results. The features of these surfaces were also preserved even after plotting the
digitized layers from transects aligned in only one orientation (e.g. north-south
transects vs. east-west). These methods help confirm that the patterns observed are
not a relict of either the interpolation method or the orientation of transects in the
survey grid.
There is a clear orientation of the surface features present in the Tunu-N layer,
as can be seen in Figure 14a. The shallow dunes that this surface is composed of are
aligned at an angle of roughly 170-175° with an undulation frequency of about 5-10
m. These features lie perpendicular to the predominant (1995-1999) wind direction
(~265°, 5.3 m·s-1), which is portrayed in the upper-right-hand corner of Figure 14a
(Steffen and Box, 2001). The nearby Tunu-N AWS anemometer data (not shown)
determine that the average wind direction and speed during the formation of this layer
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surface (roughly 42 days between 21 July and 1 September 2001: see Figure 15) were
typical (266°, 5.1 m·s-1).

Figure 15. AWS sonic surface-height measurements from the Tunu-N GC-Net AWS
between July 1, 2000 and May 31, 2003 (Steffen et al. 1996).
The two reflection horizons at NASA-U, on the other hand, are more
homogenous and noisy in their surface features (Figure 14c,e), especially in the upper
layer (Figure 14c). It is difficult to ascertain any preferred orientation or undulation
frequency of these features as a result. Several plausible reasons for this will be
explained below. The predominant (1995-1999) wind direction is shown as ~130° at
6.4 m·s-1, and according to the same logic applied to the Tunu-N surface, one would
expect shallow dunes to align perpendicular to this (i.e. ~220°) if they had been
allowed to form properly. The NASA-U AWS anemometer data (not shown)
determine that the average wind direction and speed during the formation of NASA-U
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layer 2 was also typical for the region (157° at 6.9 m·s-1 for layer 2; no data for layer
1).
The statistics that describe the three different reflection horizons are shown in
Table 1, including their mean depths and standard deviations, as well as the total
range in depth and—in cases where it was feasible—how the means compare against
depths of the same layers as identified in both manual snow pit stratigraphy analysis
(Figure 16) and a nearby AWS sonic surface-height instrument (Figure 15). The
values used to compute these statistics are the digitized reflection horizons from each
of the individual survey grid transects and not the kriged three-dimensional surfaces
shown in Figure 14, so as to avoid any errors introduced by interpolation. To convert
these depth values to measurements of snow water equivalent (SWE) in millimeters,
the reader only need multiply the depth values by the average snow density at each of
the sites (~0.3 g·cm-3), divide by the density of water (1 g·cm-3), and then multiply by
10 (to convert from cm to mm). Because the layers identified at NASA-U were
determined from snow pit stratigraphy and the AWS surface height data not to
correspond to annual accumulation surfaces, these GPR layers are not compared to
the NASA-U AWS surface height data. Furthermore, NASA-U layer 1 occurs over a
period when the AWS failed to record measurements.
The statistics in Table 1 show that the three layers have a standard deviation
of between 7.42 cm and 12.21 cm with an average standard deviation of 10.58 cm.
This implies that the average local-scale spatial variability at these sites in the upper
five meters is about 10 cm on average. The total range of depth values over the course
of the survey, however, extends more widely between 53.36 cm and 86.14 cm with an

TABLE 1. Depth comparison of stratigraphic layers identified within the GPR data compared to their corresponding depths identified
in a snow pit and by a nearby AWS sonic surface-height sensor, where possible. These values can be converted to SWE (mm) by
multiplying by an average snow density of ~0.3 g·cm-3, dividing by the density of water (1 g·cm-3), and multipling by 10. N is the
number of measurements in the GPR data included in the computations of mean depth and range.
Site

Layer

Date

N

Mean Depth
(cm ±1 S.D.)

Depth Range
(cm)

Snow Pit
(cm)

AWS
(cm)

Tunu-N

1

summer
2001

42554

65.60 (± 12.21)

33.82 – 105.47

50

64

NASA-U

1

wind crust

29291

49.92 (± 7.42)

35.18 – 88.54

54

n/a

NASA-U

2

31010

302.21 (± 11.32)

269.95 – 356.09

n/a

n/a

2002
ice layer
2000

39

40
average range of about 70 cm. Together, these statistics imply that a given point
measurement of depth at these sites would be expected to be off by ±10 cm on
average but could be unrepresentative by as much as ±35 cm. With a mean depth of
only 65.60 cm for the reflection horizon identified at Tunu-N, this means that any
given point measurement taken within the survey site (e.g. ice core, snow pit, AWS
sensor, manual probe, etc.) would be in error by 15% on average or as much as 53%
compared to the survey mean.
To get a sense of how accurately the layers were manually traced in ENVI,
Table 2 also shows the statistics for a comparison of the depths of points that intersect
within the survey grid (i.e. cross-points). Overall, the depths at these cross-over
points stray on average by about 8 cm, only somewhat less than the standard
deviation of depth reported in Table 1 (~10 cm on average). Unfortunately, this
would suggest that the human error in identifying the layers within the GPR data is
almost as great as the natural variability of the layers themselves. There are a few
alternative explanations for the relatively poor agreement of these cross-over points,
however:
First of all, cross-over points were selected as points within the survey grid
that could be identified as having identical latitude and longitude GPS coordinates;
given that the GPS data are non-differential, their accuracy is only on the order of 1-2
m, which means that the cross-over points that are being compared may not always
precisely intersect. Secondly, the effective footprint of the GPR transmitter is oriented
in a particular direction and will therefore see a slightly different portion of the
subsurface when the antenna is aligned differently (e.g. north-south transects vs. east-
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TABLE 2. Validation of stratigraphic layers identified within the GPR data by
comparison of depths of these layers at cross-over points within the GPR survey grid.
N is the number of identifiable cross-over points included in the measurements. Mean
layer depths vary slightly from Table 1 because of the smaller sample size.
Site

Tunu-N
NASA-U
NASA-U

Layer

N

Mean Depth
(cm)

1
1
2

50
53
60

60.17
48.42
305.19
Overall:

Mean Cross-Over
Difference
(cm ±1 S.D.)
10.64 (± 7.71)
4.30 (± 3.09)
9.93 (± 7.93)

Range in CrossOver Difference
(cm)
0.07 – 28.85
0.00 – 12.85
0.00 – 33.71

8.32 (± 7.20)

0.00 – 33.71

west transects). The high resolution of these GPR data also make certain sections of
the layers difficult to identify due to noise. Lastly, the large number of echoes present
in these data can lead to errors in the particular echo being traced in any given
transect, although this effect has been minimized as greatly as possible through
careful identification of layers during the digitization process.
Figure 16 illustrates the manual snow-pit stratigraphy analyses that were
conducted at one corner of each of the Tunu-N and NASA-U survey grids for
validation purposes. Table 1 has a snow pit column that can be used to compare the
depth of isochronous layers between the GPR data and the manual snow pit estimate.
One should note that the Tunu-N layer is incorrectly identified in the snow pit
analysis (Figure 16) as belonging to the summer accumulation surface of 2002,
whereas the AWS surface-height time series (Figure 15) reveals that this layer
actually belongs to the summer of 2001. Compared to the mean depth of the GPR
surveys, the snow pit estimate at Tunu-N differs by -16 cm (-24%), whereas the wind
crust layer at NASA-U only differs by +4 cm (+8%). Both of these snow pit estimates
are within the reported range of the GPR data, which suggests that the same layers are
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Figure 16. Manual snow pit stratigraphy analyses from the Tunu-N and NASA-U
survey grids. Snow density is in units of kg·m-3. Image courtesy of Russell Huff.
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indeed being compared, although the Tunu-N snow pit estimate differs by more than
one standard deviation compared to the GPR mean depth. For the second NASA-U
layer, no corresponding layer was identified in the NASA-U snow pit analysis for
comparison, suggesting that the layer was discontinuous, which was also evident in
the GPR data.
In addition to the snow pit comparison, a sonic surface-height measurement
has also been employed from the nearby AWS tower at the Tunu-N survey site for
another independent point measurement to compare against the GPR survey (Figure
15). Since these measurements have been collected every 10 minutes from 1996 to
the present, the time series of surface height can also be used to derive the age of the
GPR layer and the time period over which the layer was formed and then
subsequently covered by new snow. The depth of the Tunu-N layer as derived from
the AWS data agrees well with the mean GPR depth, which disagree by only -1.6 cm
(-2.4%).
The AWS data show that the Tunu-N layer is the summer surface for 2001
(Figure 15), last experiencing new snow on around 21 July after which it slowly
compacted and was exposed to wind for a relatively lengthy period of ~42 days
before new snow arrived and covered it on around 1 September. The shallow 2002
summer surface at a depth of ~26 cm was not identifiable in the GPR data and surely
lost in the GPR’s near-field zone. Though we do not have AWS data to compare
against NASA-U layer 1, we can see from the snow pit stratigraphy (Figure 16) that
there were a series of closely spaced wind crusts occurring near the mean depth of
this layer (~50 cm), suggesting that the layer identified in the GPR data was
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successively covered with new snow events. This can help explain why surface
features have better expression and a much more obvious orientation in the kriged
Tunu-N surface compared to those interpolated from NASA-U layer 1 (Figure 14).
The absence of NASA-U layer 2 in the snow pit stratigraphy and its discontinuity in
the GPR data, furthermore, suggest that this layer may be the result of percolation and
refreezing from a previous melt event. Such a layer would not have been shaped by
wind, therefore, and could also be expected to portray the relatively homogenous
spatial patterns shown in Figure 14e.

4. Discussion

The purpose of the present study was to determine snow accumulation
variability at the local-scale at two sites in the accumulation zone of the Greenland ice
sheet. An estimate of this variability was made possible by conducting 100-m by 100m GPR surveys, which can detect the presence of stratigraphic layers through the
electromagnetic contrast of differing snow-crystal grain sizes in the subsurface caused
by a variety of factors previously described, most notably the presence of hoar frost
that sometimes develops after the onset of warmer temperatures during the summer
months. Current maps of accumulation on the Greenland ice sheet (Ohmura and
Reeh, 1991; Bales et al., 2001) are compilations of points measurements (e.g. ice
cores, manual probes, snow pits). Having an estimate for the spatial variability of
snow accumulation can help determine how representative such point measurements
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are for their respective regions, thereby ultimately characterizing the magnitude of
error bars or standard deviations that should be attached to the available accumulation
maps.
The results of the current study can begin to address these concerns for at least
two widely separated locations on Greenland: Tunu-N and NASA-U. The results
suggest that spatial variability in the depth of stratigraphic layers at these two sites—
and thereby the surface roughness of these layers—is on the order of ±10 cm (1 S.D.),
with a range extending to as much as ±35 cm. Given that Tunu-N has on average
about 100-150 mm·yr-1 of snow water equivalent (SWE) (Bales et al. 2001), or about
40 cm of snow in terms of depth, this means that a point estimate of accumulation at
Tunu-N for a given year would have an expected error of ±25% but could be off by as
much as ±88%. NASA-U, on the other hand, gets about 200-300 mm·yr-1 of SWE on
average (Bales et al., 2001), or about 75 cm of snow in terms of depth, which means a
point estimate would have about half the expected error of Tunu-N (±13%) and a
lower range in error (±47%). Interestingly, the magnitude of these errors agrees well
with the estimated error of 20-25% reported for the available accumulation maps
(Ohmura and Reeh, 1991; Bales et al., 2001; Cogley, 2004). The current study only
surveys two sites, however, and how well these data represent other regions on the
Greenland ice sheet can only be investigated through additional GPR surveys in the
future.
In comparing the Tunu-N and NASA-U results, it is apparent in the
orthogonal visualizations of Figure 14 that the surface features in the Tunu-N layer
have a clear orientation (Figure 14a) while those of the NASA-U layers have little-to-
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no organized spatial pattern (Figure 14c,e). As previously suggested, this could be the
result of the relative amount of time that these layers were left uncovered by new
snow and exposed to the winds, and the likelihood that NASA-U layer 2 is a
discontinuous ice layer formed by percolation and refreezing of melt water. The
Tunu-N layer was an exposed surface for ~42 days, allowing the wind to carve
features and form dunes into that surface that align perpendicular to the prevailing
wind direction as do sand dunes. NASA-U layer 1, on the other hand, may not have
been exposed long enough to significantly express these features before they were
superimposed by new snow, which can help explain the lack of any obvious
orientation or dominant spatial pattern. Because the wind speed was nearly equivalent
at both sites at the time of layer formation (~5 m·s-1), the strength of the wind cannot
also be used as an argument as to why surface features are better expressed at one site
compared to another.
Another possible partial explanation for the homogeneity of the NASA-U
layers is the greater difficulty of identifying layers within the NASA-U GPR data
compared to Tunu-N. NASA-U layer 1 was at a mean depth of 49.92 ± 7.42 cm,
placing it at the edge of the instrument’s near-field zone. Recall from the introduction
that the near-field zone of a GPR instrument is a region of high distortion that occurs
in the data from the surface down to a depth of ~1.5 times the transmitter frequency,
when the radar signal is still in the process of coupling with the subsurface. Since
these data were collected at a frequency of 1000 MHz, which corresponds to a
wavelength of ~30 cm, this near-field zone extends to a depth of about 45 cm. In
short, it was difficult to ascertain the depth of layer 1 along several sectors of the
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GPR survey grid. In addition, NASA-U layer 2 was deep enough (302.21 ± 11.32 cm)
that the signal had become quite faint (recall that radar amplitude decreases
exponentially with depth). Even after applying a depth-varying gain filter to the data,
layer 2 was also intermittently difficult to digitize because of high levels of noise and
discontinuity. For each of these reasons, there is less confidence in the digitized
layers at NASA-U and this may partially explain the lack of obvious surface patterns.
The GPR surveys described in the current study were conducted as pilot
studies to investigate the feasibility of assessing spatial variability in snow
accumulation on the Greenland ice sheet. As previously described, software tools
were developed to enable the processing and analysis of these and future GPR data.
The results of this study show that it is indeed feasible to measure spatial variability
in snow accumulation at the local scale and at relatively shallow depths using highresolution GPR. However, the greatest strength of these GPR data (high-resolution)
can also be interpreted as their greatest weakness (high levels of noise). Even after
our best filtering attempts, the remaining presence of noise, prevalence of echoes (at
times overlapping echoes from distinct reflection horizons), the near-field distortion
zone, and exponential loss of signal with depth all challenge the accurate
identification of and absolute depth measurement of stratigraphic layers within the
subsurface. Future efforts could likely benefit from more advanced signal processing
to help further alleviate some of these problems; use of a broadband, continuouswave radar such as FMCW would also be worth investigating for comparison against
the single-frequency, pulsed radar methodology employed in the present study.
Complexity in the subsurface stratigraphy (e.g. discontinuous layers; significant
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layers from sources other than annual hoar frost such as melt percolation, ice lenses,
and/or wind compaction) can also make interpretation of the GPR radargram difficult,
and the acquisition of manual snow pit stratigraphy and/or other data such as AWS
snow-height and wind data are practically a necessity.
Although similar studies have been conducted with GPR on glaciers in
Svalbard and on the Antarctic ice sheet also for the purposes of assessing snow
accumulation variability (as described in the introduction), this is the first such study
collected on Greenland. Previous studies have also focused mostly on assessing
variability over long transects (> 1 km) rather than on acquiring a survey grid that
could then be used to generate a three-dimensional surface for assessing local-scale
spatial patterns. Most of these previous studies also employ lower antenna
frequencies (e.g. 250-500 MHz), which aim at assessing cumulative features at
greater depths rather than on identifying individual stratigraphic layers in the shallow
subsurface, which requires greater resolution. The message of all of the previous
studies as well as the current one, however, is that spatial variability can and often
plays an important role in the snow accumulation of glaciers and ice sheets, even
where there is apparently flat terrain. Whereas point measurements have been
frequently and predominantly employed for assessing accumulation on glaciers and
ice sheets and spaceborne methods such as scatterometry are also beginning to be
developed for monitoring accumulation (Drinkwater et al., 2001; Nghiem et al.,
2005), it is important that we assess how accurately these measurements are
representative of wider regions. GPR is a useful tool for accomplishing this, as has
been demonstrated by the current study.
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Appendix A. Data Processing Instructions
This Appendix provides some guidelines on how the Malå Geoscience RAMAC™
(http://ramac.malags.com) ground-penetrating radar (GPR) data were processed for
this thesis to help others who may need to accomplish similar tasks in the future or to
reproduce the reported results. Where custom-made IDL procedures are referred to
(*.pro), please refer to Appendix B for documentation and installation instructions.
The GPR data were processed on a Windows PC (1.8 GHz CPU, 256 MB RAM)
using the following software packages and programming languages:
•
•

•

Malå Geoscience GroundVision (Version 1.3.6) GPR data acquisition and
filtering software (http://www.malags.com/software/#groundvision).
Research Systems, Inc.'s (RSI) Interactive Data Language (IDL) (Version 6.1)
for use within RSI's Environment for Visualizing Images (ENVI) (Version
4.1) software (http://rsinc.com).
Golden Software, Inc.'s Surfer (Version 8.00) contouring, gridding, and
surface mapping software
(http://www.goldensoftware.com/products/surfer/surfer.shtml).

Contents:
A.1. Opening Files In ENVI
A.2. Subsetting
A.3. Filtering
A.4. Tracing Layers
A.5. Creating 3-D Surfaces
A.6. Computing Statistics
A.1. Opening Files In ENVI
An IDL procedure has been written to easily import RAMAC GPR data into ENVI.
Refer to the documentation and installation instructions for
“open_ramac_gpr_file.pro” in Appendix B for further details, including step-by-step
instructions for opening the RAMAC GPR data in ENVI manually without the use of
this procedure. After installing this IDL procedure, follow these steps:
a.) Open ENVI.
b.) File > Open External File > GPR > RAMAC
c.) Select a RAMAC GPR file (*.rd3) to open.
d.) The “open_ramac_gpr_file.pro” procedure will automatically read the
RAMAC GPR header file (*.rad) associated with the selected data file
(*.rd3) to determine the dimensions of the data file. The procedure also
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rotates the file into the proper orientation for viewing as is necessary when
opening these data into ENVI.
e.) The result is saved to memory and will be listed in the ENVI “Available
Bands List” window. Select the image (e.g. “Rotated (filename.rd3)”) and
press “Load Band” to view the data.
f.) To view the depth and distance of the current cursor location as you scroll
over the image window, select “Cursor Depth/Distance” from the “GPR”
menu of the image window. This will require that you have installed
several of the files listed in Appendix B.3. under the heading “Cursor
Depth/Distance”.
A.2. Subsetting
If the original GPR file contains multiple transects associated with a survey grid, it is
easier to work with the data if each of the individual transects are contained in their
own, individual file. Otherwise, it becomes cumbersome always needing to locate
what part of the original file contains your current transect of interest, and it may also
be slower to do processing on a file of that size. Furthermore, several of the filters
will work better on smaller files since otherwise they may do things such as remove
the mean trace over your entire file, which may contain drifting average brightness
levels over time and may also contain sections that you are not interested in including
in the filtering process (e.g. regions between transects in a survey grid).
The following steps describe how to split up the original GPR file into individual files
by transect:
a.) Open the original file in ENVI as described in part A.1. above.
b.) Write down on a piece of paper or record into a spreadsheet the start and
end trace (horizontal- or x- dimension) for each transect. You can find the
start and end trace of each transect by scrolling through the data file in
ENVI and visually noting when the GPR instrument was being pulled vs.
when it was being held stationary between transects: when the GPR was
stationary, only straight, horizontal bands appear (from antenna ringing) but
no squiggly layers or echoes. To determine the trace number (or "sample"
number, in ENVI’s terminology) use the "Tools" pull-down menu above
the image window and select "Cursor Location/Value...". This will bring up
a window that displays the (x,y) coordinates and the data value of whatever
pixel that the mouse pointer is currently pointed at. You can use this to
determine the x coordinate for the start and end of each transect (the y
coordinate is irrelevant). If the default contrast of the image does not allow
you to easily view the divisions between transects, use the "Enhance" pulldown menu and select one of the available contrast stretches: the "[Zoom]
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Linear 2%" usually provides a suitable contrast. Another useful tool for
helping you move through the data file without having to drag the red zoom
box within the "Scroll" window is the "Pixel Locator..." tool underneath the
"Tools" menu. Here you can specify a sample number to move to within the
data file. If you are currently viewing traces/samples 1-500, for example,
you can use the "Pixel Locator" to move to trace/sample #501 to begin
viewing traces/samples 501-1000 for further transect divisions.
c.) After you have recorded the start and end traces/samples for each transect,
you can then begin subsetting the original GPR file into these individual
transects. Because ENVI does not provide a stand-alone "subset" function
that allows you to specify coordinates to subset a file by, subsetting must be
accomplished within another pre-existing ENVI function. Most ENVI
functions that perform an operation on a data file allow you to perform that
function on a spatial subset of the file. I choose to use the "Rotate/Flip
Data" function in the "Basic Tools" pull-down menu at the top of the
screen. On the "Rotation Input File" window that pops up, select the
original GPR data file that you wish to subset (*.rd3). Press the "Spatial
Subset" button that then appears. In the "Select Spatial Subset" window that
follows, enter the start and end trace/sample for the first transect in the
"Samples" and adjacent "To" input boxes. It will automatically compute the
number of samples that this contains in the "NS" box. Keep the default
number of "Lines" and press "OK". Back on the "Rotation Input File"
window, now press "OK". In the "Rotation Parameters" window that
follows, leave the default rotation "Angle" of zero and default "Transpose"
to "No": this means that no rotation will be performed on the data, which is
what we want since subsetting is our objective here and not rotation. Select
to output the result to a file and choose a filename for the output: for
example, "filename_t01.bin" for the first transect ("bin" for binary).
Keep the default "Background Value" of zero and press "OK". The image
rotation (or lack thereof, in this case) will take a few seconds to perform
and then the transect will appear as its own file in the "Available Bands
List" window.
d.) After the subsetted file appears in the "Available Bands List" window,
select the new filename in the window (e.g. "filename_t01.bin"), rightclick, and select "Edit Header...". In the "Header Info" window that follows,
select "Band Names..." from the "Edit Attributes" pull-down menu. In the
"Edit Band Name values" window that appears, select the current band
name: e.g. "Rotate (Band 1:filename.rd3)". In the "Edit Selected Item" box,
change the band name to just "Band 1": because no rotation was actually
performed on the data, we don't want this to mislead people in the future.
Then, back on the "Header Info" window, change the "xstart" value to the
start trace/sample number as identified in the original data file
(filename.rd3) instead of the default of 1 and then press "OK": this will
allow us to always remember where the transect is situated within the

56
original data file. It also allows us to "link" the transect file and the original
file in ENVI to visually compare them if we ever need to. "Linking" the
two files is a good thing to do now, as well, to ensure that everything was
entered correctly. To do so, first select the file in the "Available Bands
List", select "New Display" under the "Display #1" pull-down menu, and
then press "Load Band" to view the subsetted file in a new window. In the
image window of the Subsetted file, then, select "Link->Link Displays..."
from the "Tools" pull-down menu. Press "OK" in the "Link Displays"
window that appears. Both the original data file in the first window and the
subsetted file in the second window will now be viewing the same data.
Press the mouse over the subsetted data file image window to see and
compare the original data file with the subsetted data: besides having
differing contrasts, the data should be identical. If they are not identical,
you have made an error in one of the above steps. You should also visually
inspect the subsetted file to ensure that the file contains a full and proper
transect and does not erroneously contain any transect divisions. If you are
satisfied that the subsetted file is correct, right-click on the subsetted file in
the "Available Bands List" window and select "Close Selected File" to
close the file.
e.) Repeat steps c and d until all of the transects have been subsetted from the
original data into their own individual files.
f.) Open the ENVI header file for each of the resulting transect files (e.g.
"filename_t01.hdr") and edit the "description" field. By default, it will
say something like "File Rotation Result [Wed Apr 13 22:18:54 2005]".
Because there was no rotation performed on the files, however, (again, we
just used the rotate function to perform subsetting) this description should
be changed to something more useful that you would want users of the data
to know. Note that the description could have been edited back in step d in
the "Header Info" window, but I have found that this results in some words
getting strung together. Note also that you cannot use commas in the
description if you want it to properly appear within ENVI (everything after
a comma is omitted in ENVI, I have noticed).
A.3. Filtering
To optimize viewability of internal reflecting horizons (IRH) (e.g. stratigraphic layers
within a glacial snowpack), GPR data often need to be filtered due to a variety of
factors (noise, loss of signal with depth, antenna ringing, etc.).
a.) Open the data in GroundVision to investigate which combination of filters
and filter parameters are optimal for viewing the data. GroundVision is
good for experimenting with the filters because they can be applied and
edited very quickly. This is because GroundVision does not actually apply
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the filters to the entire file; it only applies the filters to the currently
displayed portion of the data. Furthermore, the filters are for display
purposes only and the filtered data cannot be saved (which is why I have
written similar filters in IDL/ENVI). In GroundVision, select “Filter”
under the “Radargram” menu. You may use any combination of the
following four filters, which are the most important and have been
simulated in IDL:
•
•
•
•

Automatic gain control
Subtract Mean Trace
Time Varying Gain
DC removal

Write down what filters you have used, what order you have applied them
in, and what settings you used to apply each of them. These settings will
now be used in ENVI.
b.) Open the same RAMAC GPR file or subset in ENVI (see A.1.).
c.) ENVI should automatically apply a linear 2% gain adjustment to any data
that you view in ENVI. This is similar to applying the “Automatic gain
control” filter in GroundVision. To try different gain adjustments, select
one of the enhancements under the “Enhance” menu of the image window.
Likely you will get the best results by using either “[Image] Linear 2%”,
“[Scroll] Linear 2%”, or “[Zoom] Linear 2%”.
d.) Make sure you have installed and read the documentation for the following
custom-made IDL filtering procedures:
•
•
•
•
•
•
•

subtract_mean_trace.pro
collect_input_subtract_mean_trace.pro
time_varying_gain.pro
collect_input_time_varying_gain.pro
dc_removal.pro
collect_input_dc_removal.pro
bulk_gpr_filter.pro

e.) Apply each of the filters that you used in GroundVision in the same order
and with the same settings. To do this, select each of the necessary filters
from the “GPR > Filter” menu on the image window. You can either
choose to save the one or each of the filtering results to your computer, or
you can select to output some or all of them to memory. Likely you will
want to output the results to memory until you are applying the last filter,
at which point you may decide to save the final result to your computer.
Note that information about the filters applied will be written to the
description in the associated ENVI header file (*.hdr) for future reference.
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f.) If you have an entire series of files that you wish to filter using the same
filter sequence and settings, you may alternatively use the “Bulk Filter”
option under the “GPR” menu on the main ENVI menu bar. You would
probably want to do this, for example, if you had split up your original GPR
file into many individual subsets (see A.2.) and now wish to filter each of
these files using the same settings. Note that you will probably get better
filter results if you subset the file into transects and filter those rather than
filtering the entire file at once, which may drift in its average brightness
over time or include regions that you are not interested in.
g.) Just to provide some examples, the Tunu-N data that I analyzed from 2003
used the following filters and settings, listed in the order they were applied:
1. Subtract Mean Trace: method = running average; window length =
5%.
2. Time-Varying Gain: time window = 42.522624; start sample = 1;
linear gain = 136; exponential gain = 80.
The NASA-U data that I analyzed from 2003 were filtered as so:
1. Subtract Mean Trace: method = running average; window length =
5%.
2. Time-Varying Gain: time window = 66.146304; start sample = 1;
linear gain = 780; exponential gain = 0.
GPR data from the Petermann ice tongue in northwestern Greenland (not
part of this thesis):
1. Time-Varying Gain: time window = 5247.0000; start sample = 70;
linear gain = 3; exponential gain = 0.
A.4. Tracing Layers
Once the GPR data have been optimally filtered as described in section A.3. and the
desired linear features are visible, these features (e.g. stratigraphic layers, basal
topography of a floating ice tongue, permafrost layer, etc.) can be easily traced with
the mouse in ENVI using ENVI’s Region Of Interest (ROI) tool:
a.) In the image window, go to “Tools > Region Of Interest > ROI Tool…”.
b.) In the ROI Tool window, select “Polyline” under the “ROI_Type” menu.
c.) Hold down the left mouse button to begin tracing the layer. Let go of the
left mouse button when you are ready to save the layer. Press the right
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mouse button twice to accept the result. (For more details on tracing layers
with the ROI Tool, go to the “Help” menu of the ROI Tool window.)
d.) File > Save ROIs…
e.) Do the same for all transects related to these GPR data if you have created
subsets as described in A.2.
f.) Saving the ROI into an ROI file (*.roi) stores the pixel address of every
pixel contained within the polyline that you have traced. These pixel
addresses can be later used to generate a 3-D surface of this layer (see
A.5.) and to compute depth statistics (see A.6.). Obviously, the success of
the results will depend on how carefully and accurately you have traced the
features of interest using the ROI Tool.
g.) Though I created prototypes for automatically detecting linear features
based on a starting and ending point identified by the user, this turned out
to be unsuccessful given how noisy most GPR data and because of the high
prevalence of echoes in the data. As a result, manual layer tracing using the
ENVI ROI Tool is the best tool for doing this.
A.5. Creating 3-D Surfaces
Now that one or more linear features have been identified in the GPR data file or
transects (subsets) using ENVI’s polyline Region Of Interest (ROI) tool, the latitude,
longitude, and depth of each pixel in these features can be used to generate a threedimensional (3-D) surface. This is accomplished using custom-made IDL programs
that can compute the depth of the pixel (based on various input criteria) as well as
extract the corresponding latitude and longitude for each pixel from the RAMAC
GPS coordinates file (.cor) that was hopefully collected during the acquisition of the
GPR data. See the programs listed in Appendix B.3. for documentation and
installation instructions regarding these particular programs.
a.) In order to create a 3-D surface, the latitude, longitude, and depth must first
be output to a text file. Given that there are three dimensions to these data,
this is called an XYZ file. If you wish to generate an XYZ file for a single
GPR file and corresponding ROI file (*.roi), select “Create XYZ File…”
from the “GPR” menu of the image window in ENVI. If you wish to
generate an XYZ file for multiple GPR files and their corresponding ROI
files, however, select “Create XYZ File” from the “GPR” menu of the
main ENVI menu bar. This function will ask you for the location of the
necessary ROI file(s), RAMAC header file (*.rad), and RAMAC GPS
coordinates file (*.cor) in addition to settings for converting time to depth
and a location for writing the output XYZ file to.
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b.) Now that you have an irregular collection of geographic points, these need
to be gridded and interpolated to generate a 3-D surface. This can either be
done using IDL’s “iTools” or the Surfer software application (or other
tools of your choosing). For using iTools, use the IDL Help page to look
up “iTools” (in short, however, you can type “ICONTOUR” at the IDL
prompt to start the tool). This is a relatively easy application to use for
gridding and viewing data in 3-D with a series of graphical user interfaces
(GUI). In my experience, however, creating the final images in iTools was
not as flexible and elegant as Surfer. My remaining instructions, therefore,
pertain to Surfer.
c.) Open Surfer and select “Grid > Data…”.
d.) Select the XYZ file that you generated above in step b for gridding.
e.) I used kriging as my gridding method but got similar results from various
other methods; another option that I liked was “Triangulation with Linear
Interpolation”. The method you choose is up to you. For the most part, I
just used all of the default settings, but you could also investigate the
“Advanced Options…” on this screen. By default it will create a Surfer
grid file (*.grd) in the same directory as the XYZ file.
f.) After the grid file has been generated (*.grd), you can now view this file in
3-D. Select “New” from the main Surfer “File” menu and choose “Plot
Document”. On the right-hand side of the screen are different types of
visualizations that you can generate from the Surfer grid file. Select
to
generate a 3-D surface plot; similarly, you can select “Surface…” from the
main Surfer “Map” menu. Select the Surfer grid file (*.grd) that you
generated above.
g.) You may need to adjust the scale of the resulting 3-D surface plot. For
instance, since my GPR survey was 100-m by 100-m, I adjusted the scale
of the X and Y axes to be the same. To do this, double-click on “3D
Surface” on the left-hand side of the screen to adjust settings for the plot.
Go to the “Scale” tab, unselect “Proportional XY Scaling”, and set the
length of the X scale to be equal to that of the Y scale. Similarly, adjust the
scale of the Z axis for vertical exaggeration or true scale settings,
depending on your desired output. The other important tab for the 3D
Surface Properties is the “View” tab: here you can adjust the perspective at
which the surface is viewed.
h.) You can easily adjust each of the axes, all of the fonts, add labels, add a
color bar, etc. I found that Surfer is extremely flexible and easy to use for
creating the output image that you desire.
i.) When you have adjusted the plot to your liking, do “File > Save” to save
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the result as a Surfer plot file (*.srf) that can be opened again and further
edited in Surfer. You can also select “File > Export” to export the file in a
variety of image formats, including PNG, TIFF, JPEG, GIF, BMP, ESRI
Shapefile, etc.
A.6. Computing Statistics
Now that one or more linear features have been identified in the GPR data file or
transects (subsets) using ENVI’s polyline Region Of Interest (ROI) tool, the depth of
each pixel in these features can also be used to compute depth and snow water
equivalent (SWE) statistics. This is accomplished using custom-made IDL programs
that can compute the depth of the pixel (based on various input criteria). See the
programs listed in Appendix B.3. for documentation and installation instructions
regarding these particular programs. The depth and SWE statistics that are reported
are the mean, standard deviation, minimum, and maximum as well as the total
number of pixels used in the calculations. These statistics can be generated as so:
a.) If you wish to compute statistics for a single GPR file and corresponding
ROI file (*.roi), select “Compute Depth Statistics…” from the “GPR”
menu of the image window in ENVI. If you wish to compute statistics for
multiple GPR files and their corresponding ROI files, however, select
“Compute Depth Statistics” from the “GPR” menu of the main ENVI menu
bar. This function will ask you for the location of the necessary ROI file(s)
and RAMAC header file (*.rad) in addition to settings for converting time
to depth and for converting depth to SWE. If the subsurface in the data is
not snow, the snow density setting for computing SWE can be ignored.
b.) The results will be printed to a separate window and can be saved to an
ASCII text file if desired.
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Appendix B. Program Documentation And Installation Instructions
The following software tools have been created for opening, filtering, and analyzing
Malå Geoscience RAMAC™ (http://ramac.malags.com) ground-penetrating radar
(GPR) data. These tools are programmed using Research Systems, Inc.'s (RSI)
Interactive Data Language (IDL) for use within RSI's Environment for Visualizing
Images (ENVI) software (http://rsinc.com). These tools were programmed and tested
on a Windows PC using IDL 6.1 and ENVI 4.1 but should work on other operating
systems and software versions.
These software tools are saved as IDL procedures (.pro files) and should be moved to
the ENVI "save_add" directory prior to use. The location of the ENVI "save_add"
directory may vary on different systems, but can generally be found according to the
following path on a Windows computer:
C:\RSI\IDL61\products\ENVI41\save_add\
When ENVI user functions (.pro or .sav files) are placed in the ENVI "save_add"
directory, they are automatically compiled in the ENVI session's RAM when ENVI
starts. Also, once a user function has been added to ENVI, its code can be modified at
any time, recompiled from within the current ENVI session, and then used in its
modified form without having to restart ENVI.
Furthermore, these procedures can be made part of the ENVI menus. The ENVI menu
system is comprised of the "Main" menu that appears when you start ENVI and the
"Functions" menu that is accessed only from image display windows. These two
menus are defined by separate ASCII files located in the ENVI "menu" directory:
C:\RSI\IDL61\products\ENVI41\menu\
The "envi.men" file in the above directory defines the Main menu, and the
"display.men" file defines the Functions menu. Each time a new ENVI session is
started, these two menu files are read and used to construct the ENVI menus based on
the content of the files. To add a new button to one of the two menus, simply add a
new line to one of the files and restart ENVI. See "Modifying the ENVI Menus" in
the ENVI Online Help for more details on the specific syntax and format of
modifying the menu files. Each of the procedures documented below lists the
necessary lines to add to the menu files. In short, however, add the following text to
the bottom of "display.men" for the necessary tools to be displayed in the "Functions"
menu under a menu heading labeled "GPR":
C:\RSI\IDL61\products\ENVI41\menu\display.men:
0 {GPR}
1 {Filter}
2 {Subtract Mean Trace} {not used} {subtract_mean_trace}
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2 {Time-Varying Gain} {not used} {time_varying_gain}
2 {DC Removal} {not used} {dc_removal}
1 {Cursor Depth/Distance...} {not used} {cursor_depth_distance}
1 {Create XYZ File...} {not used} {collect_input_create_xyz_file}
1 {Compute Depth Statistics...} {not used}
{collect_input_compute_depth_statistics}
Next, add the following text to the "envi.men" file for the remaining tools to be
displayed on the main ENVI menu bar. These tools are added to this menu since they
can be applied to multiple GPR files and because these GPR files do not need to be
already open in ENVI for these procedures to run:
C:\RSI\IDL61\products\ENVI41\menu\envi.men:
0 {GPR}
1 {Bulk Filter} {not used} {bulk_gpr_filter}
1 {Create XYZ File} {not used} {collect_input_bulk_xyz_file}
1 {Compute Depth Statistics} {not used} {collect_input_bulk_depth_statistics}
The following should also be appended to the above “envi.men” file underneath the
existing main “File > Open External File” section for adding a tool that can open the
GPR data automatically:
C:\RSI\IDL61\products\ENVI41\menu\envi.men:
0 {File}
1 {Open External File} {separator}
2 {GPR}
3 {RAMAC} {not used} {open_ramac_gpr_file}
Lastly, in order for the “Cursor Depth/Distance” tools to work, you must also open
the ENVI "Preferences" menu from the main ENVI "File" menu. On the main tab
entitled "User Defined Files", enter "gpr_cursor_info" in the bottom text box that is
labeled "User Defined Motion Routine". Click "OK" to save the new preference and
choose to save these updated preferences to a file if you wish them to be saved after
you close and restart ENVI. The information from this procedure will not be
displayed, however, until the "Cursor Depth/Distance" function is called from either
the Main or Function "GPR" menus created above. See "cursor_depth_distance.pro"
below for further details.
The software tools created as part of this thesis are documented below and are divided
into the following categories:
B.1. Opening Files In ENVI
B.2. Filtering Tools
B.3. Analysis Tools
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B.1. Opening Files In ENVI
Contents:
a. open_ramac_gpr_file.pro
a. open_ramac_gpr_file.pro
This IDL procedure can be run in ENVI to automatically and properly import
a Malå Geoscience RAMAC™ ground-penetrating radar (GPR) data file for
viewing in ENVI (under ENVI's "File -> Open External File" file menu). The
dimensions of the data file are read from an associated RAMAC "*.rad"
header file and the data are transposed (rotated) so that they are displayed
properly. The data file is opened in ENVI in memory and given an
informative description in its ENVI header file so that if the rotated file is
saved to disk this information can be referred to later. Having a procedure
such as this one, though, prevents the need for saving an alternate format of
the GPR data just for ENVI (and thereby doubling your space requirements)
since you can view it directly from memory.
What follows are step-by-step instructions for opening a Malå Geoscience
RAMAC GPR data file (*.rd3) in ENVI manually for the first time. These are
essentially the steps that the current procedure enables automatically for the
user:
1. Determine data dimensions:
Open the *.rad file associated with the particular GPR data file that
you wish to view in order to determine its dimensions:
a.) Determine the number of pixels in the vertical/y-axis dimension of
the data. This is labeled on the first line of the *.rad file as the
number of "samples". For example:
SAMPLES:1024
This will be used to identify the number of "samples" in ENVI,
which confusingly represents the horizontal/x-axis dimension of the
data in ENVI. (The data will be flipped vertically in ENVI when we
first open the file and will subsequently require a rotation within
ENVI prior to usage.)
b.) Determine the number of pixels in the horizontal/x-axis dimension

65
of the data. This is labeled on the 22nd line of the *.rad file as the
number of the "last trace". For example:
LAST TRACE:37745
In RAMAC GPR terminology, each line of data in the horizontal
dimension is considered a single "trace" of data since it represents
the data traced by radar pulses for that particular distance along the
x-axis. The last trace represents the total number of pixels in the
horizontal dimension and will be used to identify the number of
"lines" in ENVI, which confusingly represents the vertical/y-axis
dimension of the data in ENVI. (Again, the data will be flipped
vertically in ENVI when we first open the file and will therefore
require a rotation within ENVI prior to usage.)
2. Open the file in ENVI:
Open ENVI and select "Open Image File" from the "File" pull-down
menu. Select the particular RAMAC GPR data file (*.rd3) that you
wish to open in ENVI. A "Header Info" window will appear for you to
input various characteristics about the data so that ENVI knows how to
properly display it. Using the dimensions of the data determined in
step 1 above, fill in each of the fields as so:
a.) Samples
Enter the number of "samples" determined from the *.rad file in
step 1 above (e.g. 1024).
b.) Lines
Enter the number of the "last trace" determined from the *.rad file
in step 1 above (e.g. 37745).
c.) Bands
Enter "1". RAMAC GPR data only consist of a single band of data.
d.) Offset
Enter "0". There is no header information that precedes/offsets the
RAMAC GPR data.
e.) xstart
Use the default of "1". This will define the left-most column of data
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as beginning at 1.
f.) ystart
Use the default of "1". This will define the upper-most row of data
as beginning at 1.
g.) Data Type
Select "Integer". NOTE: It is incorrect to select "Unsigned Integer"
since the RAMAC GPR data files can contain negative values and
these will be incorrectly represented as very large positive values if
you select "Unsigned Integer" as the data type.
h.) Byte Order
If the data were collected on a computer running the Windows
operating system, select "Host (Intel)" byte order. If the data were
collected on a computer running a Unix-based operating system
(ex. SGI, Sun, or Linux operating systems), select "Network
(IEEE)" byte order. If you have selected the incorrect byte order,
the data will obviously appear incorrect when displayed.
i.) File Type
Select the default of "ENVI Standard".
j.) Interleave
Select the default of "BSQ". Because the data contain only a single
band, the band interleave that you select is irrelevant and any
option will work equally well. NOTE: "BSQ" stands for bandsequential, "BIL" stands for band interleaved by line (y-dimension),
and "BIP" stands for band interleaved by pixel (x-dimension).
k.) Description
In the text box at the bottom of the window you can enter any
description of the data file that you like. The default description is
"File imported into ENVI." If desired, enter informative details
about the data file such as, "Mala Geoscience RAMAC 1000 MHz
GPR data file from the NASA-U Greenland Climate Network (GCNet) automatic weather station (AWS) collected on June 1 2003."
NOTE: Avoid commas because the description will not display
properly when viewing the header in ENVI.
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Select "OK" after entering the above selections and the file will
automatically appear in a new "Available Bands List" window. Select
The file from this window, use the default display mode of "Gray
Scale" (the data are not in color), and then select "Load Band" to load
the data for display. If any of the above fields were accidentally
entered incorrectly and the data are displayed incorrectly, you can
always right-click on the data file in the "Available Bands List"
window and select "Edit Header..." to go back to the "Header Info"
window and edit the appropriate field.
NOTE: An ENVI header file (*.hdr) will now be saved in the same
directory as the original data file (*.rd3). This file contains all of the
information entered above so that the next time you open the file in
ENVI, it will automatically pop into the "Available Bands List"
window without requiring to re-enter all of the above information in
the "Header Info" window. If the ENVI header file is ever removed or
moved to a different directory from the data file, ENVI will require
you to re-enter all of the above information the next time you attempt
to open the data file in ENVI.
3. Rotate the file in ENVI:
You will notice that the GPR data are flipped vertically when you first
open them for display in ENVI after completing steps 1-2 above. The
next step is to rotate the data so that they are oriented properly in
ENVI. To do this, select "Rotate/Flip Data" from the main ENVI
"Basic Tools" menu at the top of the screen. In the "Rotation Input
File" window that pops-up, select the GPR data file that you wish to
rotate and select "OK".
NOTE: If you are subsetting the original GPR data, you can also
choose a "Spatial Subset" before selecting "OK" to only apply and
output the rotation on a small section of the original data file. This may
be desired, for example, if the original data file contains all of the
transects that are part of a larger gridded survey and you wish to split
the data file into its individual transect components for convenience
and quickness during post-processing.
In the "Rotation Parameters" window that follows, press the toggle
button next to "Transpose" to change the option to "Yes". Use the
default of zero (0) for the rotation "Angle." Select to "Output Result
to" a file and then select an output filename (e.g. "*_ENVI.bin") if you
wish to save the rotated data. Use the default "Background Value" of
0.00. The image rotation will take some time to complete before the
new, rotated file will automatically appear in the "Available Bands
List" for display. NOTE: It is incorrect to select a rotation angle of 90
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degrees and no transpose: although this will rotate the data into the
proper orientation, it will make the first sample of the image file be the
last sample of the actual data.
4. The file is now displayed correctly in ENVI and ready for processing.
------------------------------------------------------------------------------------TO USE IN ENVI: After saving this procedure in the ENVI "save_add"
directory, look for the following line in ENVI's main menu configuration file
(envi.men) located in ENVI's "menu" directory:
1 {Open External File} {separator}
Add the following lines beneath the above line prior to opening ENVI.
2 {GPR}
3 {RAMAC} {not used} {open_ramac_gpr_file}
This procedure can then be run from the pull-down menu labeled "Open
External File" under the main "File" menu option on ENVI's main menu bar.
Along with the existing external file formats, at the top you will now see
"GPR" as a category and "RAMAC" as a type of GPR file.
------------------------------------------------------------------------------------B.2. Filtering Tools
Contents:
a. subtract_mean_trace.pro
b. collect_input_subtract_mean_trace.pro
c. time_varying_gain.pro
d. collect_input_time_varying_gain.pro
e. dc_removal.pro
f. collect_input_dc_removal.pro
g. bulk_gpr_filter.pro
a. subtract_mean_trace.pro
NOTE: Requires the following other file:
• collect_input_subtract_mean_trace.pro
This IDL procedure can be run in ENVI to simulate the "subtract mean trace"
image-processing filter available within Mala Geoscience "GroundVision"
software that is used to acquire and process Malå Geoscience RAMAC™
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ground-penetrating radar (GPR) data. As described in Appendix 1 of the
GroundVision Manual:
"This filter is used to remove horizontal and nearly horizontal features
in the radargram by subtracting a calculated mean trace from all traces.
The running average version subtracts a mean trace calculated in a
window centered at the trace to be filtered. The size of the window is
selected by the 'Number of traces to use in filter process' edit box. The
Total average method calculates the mean trace as the mean of the
whole data file."
A "trace" is a single, vertical column of GPR data, representing the signal
"traced" by a radar pulse as it travels from the instrument into the subsurface.
Each trace is composed of individual "samples," the smallest measurement
unit in the vertical dimension.
In following with the description above, this IDL procedure filters a GPR
image (that has already been formatted to view properly in ENVI) using the
following methodology:
1. Ask the user for a subtraction method (either running average or total
average) and for a window length (in traces) to apply to the filter if
running average is the selected subtraction method. This information can
be provided to the program in one of two ways:
a.) through the use of a graphical user interface (GUI) that pops up
when calling the program from within an ENVI image pull-down
menu, or
b.) automatically through the use of command-line options at the IDL
prompt or from within another IDL program (to facilitate the
application of this filter programmatically across multiple files).
The IDL procedure then applies the following mean-subtraction filter to the
data on a row-by-row basis (note: rows are oriented horizontally in the data, as
opposed to traces, which are oriented vertically):
2. Calculate the mean data value (in DN) for the row, either for the entire
row (total average method) or for a window centered around the current
trace (running average method).
3. Subtract this mean data value from each pixel in the row. Note that pixels
that used to have the mean data value will now have a data value of 0.
This also means that pixels that used to have data values less than the
mean will now be negative. Negative data values are acceptable in these
data, however.
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------------------------------------------------------------------------------------TO USE IN ENVI: After saving this procedure in the ENVI "save_add"
directory, add the following lines to ENVI's function menu configuration file
(display.men) located in ENVI's "menu" directory:
0 {GPR}
1 {Filter}
2 {Subtract Mean Trace} {not used} {subtract_mean_trace}
This procedure can then be run from the pull-down menu labeled "GPR" on a
GPR file that you have already opened in ENVI. The result can either be
saved to memory or to a new file.
------------------------------------------------------------------------------------------------------------------------------------------------------------------------TO USE IN IDL:
subtract_mean_trace, input_location = input_location, [window_length =
window_length,] output_location = output_location
Keywords:
input_location = full pathname and filename of the file to filter, surrounded by
quotes ("").
window_length (optional) = length in traces (horizontal dimension, or x-axis)
to use in the running average subtraction method. Must be an integer
between 2 and the total number of traces in the file. If this keyword is
not supplied, the program will assume a total average subtraction
method.
output_location = full pathname and filename of a file to output the filtered
result to, surrounded by quotes ("").
Examples:
subtract_mean_trace, input_location = "C:\data\ramac_gpr.bin",
window_length = 60, output_location = "C:\data\ramac_gpr_filtered.bin"
subtract_mean_trace, input_location = "/home/maurer/data/ramac_gpr.bin",
output_location = "/home/maurer/data/ramac_gpr_filtered.bin"
------------------------------------------------------------------------------------b. collect_input_subtract_mean_trace.pro
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NOTE: Requires the following other file:
• subtract_mean_trace.pro
This IDL function is called by or for the "Subtract Mean Trace" groundpenetrating radar (GPR) image-processing filter (subtract_mean_trace.pro) to
collect user input. It displays a window for the user to enter a subtraction
method (either running average or total average) and for a window length (in
traces) to apply to the filter if running average is the selected subtraction
method. A "trace" is a single, vertical column of GPR data, representing the
signal "traced" by a radar pulse as it travels from the instrument into the
subsurface.
------------------------------------------------------------------------------------TO USE IN IDL:
result = collect_input_subtract_mean_trace( [num_traces = num_traces],
[/SPECIFY_OUTPUT] )
Return Value:
result.accept = 1 if user selects "OK", 0 if "Cancel".
result.subtraction_method = either "running average" or "total average".
result.window_length = length of a sliding time window in number of traces
(horizontal- or x- dimension) over which the filter is applied. If the
optional keyword "num_traces" is not supplied, this field will instead
return the length of the window in the percent of the total number of
traces in the file (0% = 2 traces; 100% = all traces).
result.output_location = where to output filtered result, either to memory or to
a file:
result.output_location.in_memory = 1 if output is to memory.
result.output_location.name = full path and filename of file to output
to.
Keywords:
num_traces (optional) = total number of traces (horizontal- or x- dimension)
in the file being filtered. Used to provide a slider between two samples
and the total number of samples in the file for the user to select a
window length. If not provided, the slider will instead be between 0%
(2 samples) and 100% (all samples), necessary when the number of
samples in the file being filtered is not known in advance.
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SPECIFY_OUTPUT (optional) = when this keyword is set, the widget will
ask the user whether to save the output to memory or to a file; if the
user chooses to output to a file, the widget will also ask the user where
to save the file and what to name it.
Examples:
result = collect_input_subtract_mean_trace( num_traces = 1031 )
result = collect_input_subtract_mean_trace( num_traces = 1031,
/SPECIFY_OUTPUT )
result = collect_input_subtract_mean_trace()
------------------------------------------------------------------------------------c. time_varying_gain.pro
NOTE: Requires the following other file:
• collect_input_time_varying_gain.pro
This IDL procedure can be run in ENVI to simulate the "Time-Varying Gain"
image processing filter available within Mala Geoscience "GroundVision"
software that is used to acquire and process Malå Geoscience RAMAC™
ground-penetrating radar (GPR) data. As described in Appendix 1 of the
GroundVision Manual:
"The Time-Gain filter applies a time-varying gain to compensate for
amplitude loss due to spreading and attenuation. The trace is
multiplied by a gain function combining linear and an exponential
gain, with coefficients set by the user."
A "trace" is a single, vertical column of GPR data, representing the signal
"traced" by a radar pulse as it travels from the instrument into the subsurface.
Each trace is composed of individual "samples," the smallest measurement
unit in the vertical dimension. Because of geometrical "spreading," the radar
signal decreases in strength with depth as 1/r2, where r is depth.
In following with the description above, this IDL procedure filters a GPR
image (that has already been formatted to view properly in ENVI) using the
following methodology:
1. Collect the necessary user input:
a.) Ask the user for the "time window" of the GPR data being filtered.
The time window is the amount of time that the GPR instrument
was set to "listen" for radar pulses per trace at the time of data
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acquisition. This value is used to compute the gain function in step
2 below and can be found in the "*.rad" file associated with a
particular RAMAC GPR data file ("*.rd3"), labeled
"TIMEWINDOW" and reported in nanoseconds (10-9 seconds).
b.) Ask the user for the start sample at which to begin applying the
time-varying gain, providing a reasonable default as GroundVision
does. The user may prefer to set the start sample below any
outstanding features within the trace. The time-varying gain will be
applied to all samples between the selected start sample and the last
sample of each trace.
c.) Ask the user for linear (A) and exponential (B) gain factors to be
applied in the equation outlined in step 2 below. Typical values
range anywhere between 0 and ~1000 for linear gain and 0 and
~150 for exponential gain. Increasing the exponential gain has the
effect of dramatically amplifying the gain of the lower portion of
the trace, which may be important if there are features you are
looking for in the deeper portion of the GPR data.
This information can be provided to the program in one of two ways:
a.) through the use of a graphical user interface (GUI) that pops up
when calling the program from within an ENVI image pull-down
menu, or
b.) automatically through the use of command-line options at the IDL
prompt or from within another IDL program (to facilitate the
application of this filter programmatically across multiple files).
The IDL procedure then applies the following time-varying gain function to
the data on a trace-by-trace basis:
2. Multiply each sample in the trace from the selected start sample to the last
sample in the trace by a gain factor computed according to the following
equation (note: this is the same equation used in the "GroundVision"
software):
(A*time) + e^(B*time)
where "A" is the linear gain factor and "B" is the exponential gain factor
selected by the user in step 1c above. Time, here, is expressed in
microseconds (10-6 seconds) and is computed from the time window input
by the user in step 1 above (in nanoseconds, or 10-9 seconds) according to
the following equation:
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time = ((time window)/(total samples per trace)) * (number of samples
filtered so far)
where "time window" is first divided by 1000 to convert it from
nanoseconds (10-9 seconds) to microseconds (10-6 seconds).
------------------------------------------------------------------------------------TO USE IN ENVI: After saving this procedure in the ENVI "save_add"
directory, add the following lines to ENVI's function menu configuration file
(display.men) located in ENVI's "menu" directory:
0 {GPR}
1 {Filter}
2 {Time Varying Gain} {not used} {time_varying_gain}
This procedure can then be run from the pull-down menu labeled "GPR" on a
GPR file that you have already opened in ENVI. The result can either be
saved to memory or to a new file.
------------------------------------------------------------------------------------------------------------------------------------------------------------------------TO USE IN IDL:
time_varying_gain, input_location = input_location, time_window =
time_window, start_sample = start_sample, linear_gain = linear_gain,
exponential_gain = exponential_gain, output_location = output_location
Keywords:
input_location = full pathname and filename of file to filter, surrounded by
quotes ("").
time_window = the amount of time in nanoseconds (10-9 seconds) that the
GPR instrument was set to "listen" for radar pulses per trace at the
time of data acquisition.
start_sample = sample number (vertical dimension, or y-axis) to begin
applying the filter at. Must be an integer between 1 (the first sample at
the top of the file) and the total number of samples in the file.
linear_gain = scale factor to apply in linear gain component. Must be between
0 and 1000.
exponential_gain = scale factor to apply in exponential gain component. Must
be between 0 and 1000.
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output_location = full pathname and filename of file to output the filtered
result to, surrounded by quotes ("").
Examples:
time_varying_gain, input_location = "C:\data\ramac_gpr.bin", time_window =
42.522624, start_sample = 1, linear_gain = 135, exponential_gain = 80,
output_location = "C:\data\ramac_gpr_filtered.bin"
time_varying_gain, input_location = "/home/maurer/data/ramac_gpr.bin",
time_window = 5247.0, start_sample = 17, linear_gain = 0, exponential_gain
= 4, output_location = "/home/maurer/data/ramac_gpr_filtered.bin"
------------------------------------------------------------------------------------d. collect_input_time_varying_gain.pro
NOTE: Requires the following other file:
• time_varying_gain.pro
This IDL function is called by or for the "Time-Varying Gain" groundpenetrating radar (GPR) image-processing filter (time_varying_gain.pro) to
collect user input. It displays a window for the user to enter the following
information:
1. Ask the user for the "time window" of the GPR data being filtered. The
time window is the amount of time that the GPR instrument was set to
"listen" for radar pulses per trace at the time of data acquisition. This value
is used to compute the gain function and can be found in the "*.rad" file
associated with a particular RAMAC GPR data file ("*.rd3"), labeled
"TIMEWINDOW" and reported in nanoseconds (10-9 seconds).
2. Ask the user for the start sample at which to begin applying the timevarying gain, providing a reasonable default as GroundVision does. The
user may prefer to set the start sample below any outstanding features
within the trace. The time-varying gain will be applied to all samples
between the selected start sample and the last sample of each trace.
3. Ask the user for linear (A) and exponential (B) gain factors to be applied
in the filter. Typical values range anywhere between 0 and ~1000 for
linear gain and 0 and ~150 for exponential gain. Increasing the
exponential gain has the effect of dramatically amplifying the gain of the
lower portion of the trace, which may be important if there are features
you are looking for in the deeper portion of the GPR data.
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NOTE: A "trace" is a single, vertical column of GPR data, representing the
signal "traced" by a radar pulse as it travels from the instrument into the
subsurface.
------------------------------------------------------------------------------------TO USE IN IDL:
result = collect_input_time_varying_gain( [num_samples = num_samples],
[/SPECIFY_OUTPUT] )
Return Value:
result.accept = 1 if user selects "OK", 0 if "Cancel".
result.time_window = amount of time (ns) that the GPR instrument was set to
"listen" for radar pulses per trace at the time of data acquisition.
result.start_sample = start sample (vertical- or y- dimension) at which to begin
applying the time-varying gain on a trace-by-trace basis. If the
optional keyword "num_samples" is not supplied, this field will
instead return the percent (0-100) of the sample to start at between the
first sample (0%) and the last sample (100%) in the file.
result.linear_gain = linear gain factor, between 0 and 1000.
result.exponential_gain = exponential gain factor, between 0 and 1000.
result.output_location = where to output filtered result, either to memory or to
a file:
result.output_location.in_memory = 1 if output is to memory.
result.output_location.name = full path and filename of file to output
to.
Keywords:
num_samples (optional) = total number of samples (vertical- or y- dimension)
in the file being filtered. Used to provide a slider between the first
sample and the last sample for the user to select a start sample. If not
provided, the slider will instead be between 0% (first sample) and
100% (last sample), necessary when the number of samples in the file
being filtered is not known in advance.
SPECIFY_OUTPUT (optional) = when this keyword is set, the widget will
ask the user whether to save the output to memory or to a file; if the
user chooses to output to a file, the widget will also ask the user where
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to save the file and what to name it. This would not be set, for
example, if using the function programmatically to collect input
parameters for several filters before asking where to save the output
file(s) separately.
Examples:
result = collect_input_time_varying_gain( num_samples = 1024 )
result = collect_input_time_varying_gain( num_samples = 1024,
/SPECIFY_OUTPUT )
result = collect_input_time_varying_gain()
------------------------------------------------------------------------------------e. dc_removal.pro
NOTE: Requires the following other file:
• collect_input_dc_removal.pro
This IDL procedure can be run in ENVI to simulate the "DC removal" image
processing filter available within Mala Geoscience "GroundVision" software
that is used to acquire and process Malå Geoscience RAMAC™ groundpenetrating radar (GPR) data. "DC" stands for an electrical "direct current."
As described in Appendix 1 of the GroundVision Manual:
"There is often a constant offset in the amplitude of the registered
trace. This is known as the DC level or the DC offset. This filter
removes the DC component from the data. The DC component is
individually calculated and removed for each trace [...]. The sample
interval on which the DC component is calculated is specified [by the
user]. The end sample is always the last sample in each trace and the
start sample is set [by the user]."
A "trace" is a single, vertical column of GPR data, representing the signal
"traced" by a radar pulse as it travels from the instrument into the subsurface.
Each trace is composed of individual "samples," the smallest measurement
unit in the vertical dimension.
In following with the description above, this IDL procedure filters a GPR
image (that has already been formatted to view properly in ENVI) using the
following methodology:
1. Ask the user for the start sample for calculation of each trace's DC level.
This start sample should be set below any outstanding features within the
trace to cover an area where DC noise is the prominent feature. This
information can be provided to the program in one of two ways:
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a.) through the use of a graphical user interface (GUI) that pops up
when calling the program from within an ENVI image pull-down
menu, or
b.) automatically through the use of command-line options at the IDL
prompt or from within another IDL program (to facilitate the
application of this filter programmatically across multiple files).
The IDL procedure then applies the following DC removal method to the data
on a trace-by-trace basis:
2. Calculate the standard deviation of the data between the user-selected start
sample and the last sample of the trace in order to compute the offset to
be removed from the trace's data.
3. Calculate the mean data value of the entire trace.
4. For every sample in the trace, SUBTRACT the standard deviation from
the sample's data value if it is GREATER THAN the mean plus the
standard deviation. ADD the standard deviation to the sample's data value
if it is LESS THAN the mean minus the standard deviation. Otherwise, set
the sample's data value EQUAL TO the mean.
------------------------------------------------------------------------------------TO USE IN ENVI: After saving this procedure in the ENVI "save_add"
directory, add the following lines to ENVI's function menu configuration file
(display.men) located in ENVI's "menu" directory:
0 {GPR}
1 {Filter}
2 {DC Removal} {not used} {dc_removal}
This procedure can then be run from the pull-down menu labeled "GPR" on a
GPR file that you have already opened in ENVI. The result can either be
saved to memory or to a new file.
------------------------------------------------------------------------------------------------------------------------------------------------------------------------TO USE IN IDL:
dc_removal, input_location = input_location, start_sample = start_sample,
output_location = output_location
Keywords:
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input_location = full pathname and filename of file to filter, surrounded by
quotes ("").
start_sample = sample number (vertical dimension, or y-axis) to begin
calculation of DC component from. Must be an integer between 1 (the
first sample at the top of the file) and the total number of samples in
the file.
output_location = full pathname and filename of file to output the filtered
result to, surrounded by quotes ("").
Examples:
dc_removal, input_location = "C:\data\ramac_gpr.bin", start_sample = 150,
output_location = "C:\data\ramac_gpr_filtered.bin"
dc_removal, input_location = "/home/maurer/data/ramac_gpr.bin",
start_sample = 23, output_location =
"/home/maurer/data/ramac_gpr_filtered.bin"
------------------------------------------------------------------------------------f. collect_input_dc_removal.pro
NOTE: Requires the following other file:
• dc_removal.pro
This IDL function is called by or for the "DC Removal" ground-penetrating
radar (GPR) image-processing filter (dc_removal.pro) to collect user input. It
displays a window for the user to enter a start sample for calculation of each
trace's DC level. "DC" stands for an electrical "direct current." A "trace" is a
single, vertical column of GPR data, representing the signal "traced" by a
radar pulse as it travels from the instrument into the subsurface.
------------------------------------------------------------------------------------TO USE IN IDL:
result = collect_input_dc_removal( [num_samples = num_samples],
[/SPECIFY_OUTPUT] )
Return Value:
result.accept = 1 if user selects "OK", 0 if "Cancel".
result.start_sample = start sample (vertical- or y- dimension) at which to begin
computing the DC level on a trace-by-trace basis. If the optional
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keyword "num_samples" is not supplied, this field will instead return
the percent (0-100) of the sample to start at between the first sample
(0%) and the last sample (100%) in the file.
result.output_location = where to output filtered result, either to memory or to
a file:
result.output_location.in_memory = 1 if output is to memory.
result.output_location.name = full path and filename of file to output
to.
Keywords:
num_samples (optional) = total number of samples (vertical- or y- dimension)
in the file being filtered. Used to provide a slider between the first
sample and the last sample for the user to select a start sample. If not
provided, the slider will instead be between 0% (first sample) and
100% (last sample), necessary when the number of samples in the file
being filtered is not known in advance.
SPECIFY_OUTPUT (optional) = when this keyword is set, the widget will
ask the user whether to save the output to memory or to a file; if the
user chooses to output to a file, the widget will also ask the user where
to save the file and what to name it.
Examples:
result = collect_input_dc_removal( num_samples = 1024 )
result = collect_input_dc_removal( num_samples = 1024,
/SPECIFY_OUTPUT )
result = collect_input_dc_removal()
------------------------------------------------------------------------------------g. bulk_gpr_filter.pro
NOTE: Requires the following other files:
• collect_input_subtract_mean_trace.pro
• collect_input_time_varying_gain.pro
• collect_input_dc_removal.pro
This IDL procedure applies selected image-processing filters on one or more
Malå Geoscience RAMAC™ ground-penetrating radar (GPR) data files that
have been previously formatted for viewing in ENVI. The following filters
have been implemented as IDL procedures by the author to simulate filters
available within Mala Geoscience "GroundVision" software that is used to

81
acquire and process RAMAC GPR data (GroundVision does not allow the
user to permanently apply filtering to the data or to save the results to another
file):
1. Subtract Mean Trace (subtract_mean_trace.pro)
Removes horizontal and nearly horizontal features within the
radargram (i.e. "ringing") by subtracting a calculated mean trace from
all traces. NOTE: A "trace" is a single, vertical column of GPR data,
representing the signal "traced" by a radar pulse as it travels from the
instrument into the subsurface. Each trace is composed of individual
"samples," the smallest measurement unit in the vertical dimension.
2. Time-Varying Gain (time_varying_gain.pro)
Applies a time-varying (i.e. depth-varying) gain to compensate for
amplitude loss due to spreading and attenuation. Each radar trace is
multiplied by a gain function combining linear and exponential
components, with coefficients set by the user.
3. DC Removal (dc_removal.pro)
There is often a constant offset in the amplitude of each radar trace
caused by interference from direct current (DC) used to power the
GPR instrument. This filter removes the DC component from the data,
which has the effect of making the data less noisy, or smoothing the
data.
Refer to the documentation within each of the aforementioned IDL procedures
above for further details on their operation. Each is located in the ENVI
"save_add" directory.
This IDL procedure operates in the following manner:
1. Collect the necessary user input:
a.) Ask the user to select the input files to be filtered. These must all be
in the same directory. The user can use Shift-click to select multiple
contiguous files or Ctrl-click to individually select multiple files.
b.) The user must then check off the filters to be applied to the input
files from a list of the available filters and select the order in which
these filters should be applied to the files.
c.) An input window will then appear for each of the selected filters for
the user to provide the necessary parameters to be applied for these
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filters.
d.) Lastly, the user must select an output directory to save the resulting
files to. Also, a filename pattern must be determined for naming the
output files, including a basename, suffix, and the format of an
incrementing number to be inserted in the middle.
e.) Display the user's selections and ask the user for confirmation
before continuing. Also ask the user for an existing or new log file
to write messages to during processing.
2. The IDL procedure then applies the above selected filters in the order
specified on a on a file-by-file basis. A status window will display the
percentage of completion for all of the files to be filtered. This status
window includes a "Cancel" button to terminate the program prematurely.
Individual status windows are also displayed for the progress of each
individual filter that is run. Status messages will also be written to the
specified log file so that a history of events can be viewed after processing
is complete.
------------------------------------------------------------------------------------TO USE IN ENVI: After saving this procedure in the ENVI "save_add"
directory, add the following lines to ENVI's main menu configuration file
(envi.men) located in ENVI's "menu" directory:
0 {GPR}
1 {Bulk Filter} {not used} {bulk_gpr_filter}
This procedure can then be run from the pull-down menu labeled "GPR" on
ENVI's main menu bar.
------------------------------------------------------------------------------------B.3. Analysis Tools
Contents:
Cursor Depth/Distance:
a.
b.
c.
d.
e.

gpr_cursor_info.pro
cursor_depth_distance.pro
get_gpr_depth.pro
collect_input_get_gpr_depth.pro
get_gpr_distance.pro
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Create XYZ File:
f. create_xyz_file.pro
g. collect_input_create_xyz_file.pro
h. collect_input_bulk_xyz_file.pro
Compute Depth Statistics:
i. compute_depth_statistics.pro
j. collect_input_compute_depth_statistics.pro
k. collect_input_bulk_depth_statistics.pro
Cursor Depth/Distance:
a. gpr_cursor_info.pro
NOTE: Requires the following other files:
• cursor_depth_distance.pro
• get_gpr_depth.pro
• get_gpr_distance.pro
• collect_input_get_gpr_depth.pro
This IDL procedure can be run in ENVI to track the depth and distance of the
current cursor location as it is moved over any image window of a Malå
Geoscience RAMAC™ ground-penetrating radar (GPR) data file. As an
interactive user-defined ENVI motion routine, this procedure has access to
information about the position of the current pixel (i.e. the pixel under the
cursor cross-hairs). In order for ENVI to know that it must pass cursor
information to this procedure, you must first define this procedure in the
ENVI Configuration File. Under the main ENVI "File" menu, select
"Preferences". Next, under the tab entitled "User Defined Files", enter the
name of this procedure (i.e. "gpr_cursor_info") into the text box labeled "User
Defined Motion Routine" at the bottom of the form. Then press "OK" to save
the new configuration. See "User Move Routines" in the ENVI Online Help
document for further details on ENVI user-defined move and motion routines.
This procedure will then be supplied with cursor location information as you
steer the mouse over an image window of RAMAC GPR data. This
information is then used by the helper procedure entitled
"cursor_depth_distance.pro" (which should reside in the ENVI "save_add"
directory) to display a widget that will display the depth (y-axis) and distance
(x-axis) (both in meters) of the current cursor location. To compute the depth
and distance, it uses input parameters from the user supplied in a widget
displayed by "cursor_depth_distance.pro" that get saved in global variables
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and passed to two routines for calculation: "get_gpr_depth.pro" and
"get_gpr_distance.pro", respectively (both of which also should reside in the
ENVI "save_add" directory). Although the current procedure (i.e.
"gpr_cursor_info") generates the final widget that displays the cursor location,
depth and distance, this widget will not appear until
"cursor_depth_distance.pro" is called by the user: this helper procedure gets
called when the user selects "Cursor Depth/Distance..." from the "GPR" pulldown menu on the image window. Before the information can be displayed,
the user must first enter information about the current GPR file before it can
be computed; namely, the time window, ground velocity, start distance, and
end distance. See "cursor_depth_distance.pro" for further details.
------------------------------------------------------------------------------------TO USE IN ENVI: After saving this procedure in the ENVI "save_add"
directory, open the ENVI "Preferences" menu from the main ENVI "File"
menu. On the main tab entitled "User Defined Files", enter "gpr_cursor_info"
in the bottom text box that is labeled "User Defined Motion Routine". Click
"OK" to save the new preference and choose to save these updated
preferences to a file if you wish them to be saved after you close and restart
ENVI. The information from this procedure will not be displayed, however,
until the associated "cursor_depth_distance.pro" procedure is called. See
"cursor_depth_distance.pro" for further details.
------------------------------------------------------------------------------------b. cursor_depth_distance.pro
NOTE: Requires the following other files:
• gpr_cursor_info.pro
• get_gpr_depth.pro
• get_gpr_distance.pro
• collect_input_get_gpr_depth.pro
This IDL procedure can be run in ENVI to track the depth and distance of the
current cursor location as it is moved over any image window of a Malå
Geoscience RAMAC™ ground-penetrating radar (GPR) data file. The current
procedure gets called by selecting the "Cursor Depth/Distance..." option from
the "GPR" pull-down menu of the image window. A widget will then appear
that asks the user to define certain characteristics about the currently displayed
GPR file so that the cursor depth and distance can be computed. Namely, the
time window (in nanoseconds), ground velocity (in meters per nanosecond),
start distance of the left-most pixel in the data file (in meters), and the end
distance of the right-most pixel in the data file (in meters). The time window
is automatically determined from the ENVI header file (*.rad) associated with
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the current data file (*.rd3) after asking the user where the header file (*.rad)
is located.
The time window and ground velocity terminology and usage is modeled after
RAMAC GroundVision software, which similarly requires the user to enter
these parameters in order to convert time to depth for the scale bars that are
displayed to the right and left of the data imagery in GroundVision. The time
window is the amount of time (in nanoseconds) that the radar receiver was set
to "listen" for the return pulse after each radar pulse was released from the
transmitting antenna during data acquisition. If the time window is set to 40
ns, for example, that means an individual radar pulse has a maximum time
duration of 20 ns to reach a reflector and 20 more ns to reflect back to the
receiver in order to be recorded in the data file. The bottom of the data file
therefore represents a maximum duration of 20 ns for a time window of 40 ns.
The ground velocity represents (in meters per nanosecond) how fast the radar
pulses traveled through the subsurface medium being imaged in the data file.
Ground velocities range from slow (e.g. 0.03 m/ns for fresh water) to fast (e.g.
0.3 m/ns for air) and the user should refer to a GPR textbook or manual for the
proper value related to the media being imaged. For dry snow on the
Greenland ice sheet, for example, an average value of 0.236 m/ns may suffice
if the value has not been measured in a snow pit, based on an average dry
snow density of 0.3 grams per cubic centimeter that has been empirically
related to a dry snow permittivity of 1.62 by the following publication:
Mätzler, C. (1996), Microwave permittivity of dry snow. IEEE
Transactions on Geoscience and Remote Sensing. 34(2): 573-581.
Given an average dry snow permittivity of 1.62, an average radar velocity of
0.236 m/ns can be derived by dividing the speed of light in a vacuum (0.3
m/ns) by the square root of this permittivity.
The user may also select the sample of the "first arrival" of the radar pulse
reaching the subsurface: depth computations will start at this sample number
(y-axis). Often in GPR data, there is an obvious lack of backscatter at the top
of the file that results from the empty space that occurred between the antenna
and the surface. The first arrival begins at the point where obvious backscatter
begins. The user may also select whether or not to adjust the first arrival travel
time by the "direct wave." The direct wave is the part of the transmitted
energy that travels the shortest distance between the transmitter and receiver.
Due to antenna separation, the wave traveling from the transmitter directly to
the receiver (i.e. the direct wave) is received some time after the actual
transmission. This means that the transmitted pulse has already penetrated the
medium a certain distance before the direct wave is received. The result of this
is that the depth scale zero must be corrected to be accurate. The zero for the
depth scale is calculated using the first arrival value, the antenna separation,
and the first arrival adjustment velocity. The adjustment velocity can be set to
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any value. Practically however, it can be the ground velocity, the air velocity
(most common), or anything in between depending on the antenna
configuration.
The start and end distances may only be educated guess-timates if you have
not measured the distance of your GPR survey in the field. In most cases, the
start distance will be 0 meters but can be set differently. The distance of the
current cursor location will be interpolated between the provided start and end
distances. If you do not know the distance of your survey, you may provide 0
for both distances, or just make something up and ignore the distance field in
the output widget.
These input parameters are then stored in global ("common") variables that
are accessible by a user-defined ENVI motion routine named
"gpr_cursor_info.pro" that is responsible for displaying a widget window that
updates the current depth (y-axis) and distance (x-axis) (both in meters) of the
cursor as the mouse is moved over the surface of an image display of any
RAMAC GPR file. See "gpr_cursor_info.pro" for further details and on how
to set that procedure up as a viable ENVI user-defined motion routine (NOTE:
this requires changes to the ENVI Preferences).
------------------------------------------------------------------------------------TO USE IN ENVI: After saving this procedure in the ENVI "save_add"
directory, add the following lines to ENVI's function menu configuration file
(display.men) located in ENVI's "menu" directory:
0 {GPR}
1 {Cursor Depth/Distance...} {not used} {cursor_depth_distance}
This procedure can then be run from the pull-down menu labeled "GPR" on a
GPR file that you have already opened in ENVI.
------------------------------------------------------------------------------------c. get_gpr_depth.pro
This IDL function returns the depth in meters of a given sample (y-axis) in a
Malå Geoscience RAMAC™ ground-penetrating radar (GPR) data file based
on the time window (in nanoseconds) of the data file and the ground velocity
(in meters per nanosecond) of radar through the imaged subsurface
medium/media.
NOTE: A "trace" is a single, vertical column of GPR data, representing the
signal "traced" by a radar pulse as it travels from the instrument into the
subsurface. Traces are herein described to be composed of a number of
samples (vertical dimension, or y-axis), and the number of traces are used to
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describe the horizontal dimension, or x-axis. Note that in ENVI-terminology,
"samples" are counted in the horizontal dimension, in contrast, and "lines" are
counted in the vertical dimension, but we use GPR-terminology here instead
to avoid confusion.
The "time window" and "ground velocity" terminology are common in the
GPR literature and are herein modeled after RAMAC GroundVision software,
which similarly requires the user to enter these parameters in order to convert
time to depth for the scale bars that are displayed to the right and left of the
data imagery in GroundVision. The time window is the amount of time (in
nanoseconds) that the radar receiver was set to "listen" for the return pulse
after each radar pulse was released from the transmitting antenna during data
acquisition. If the time window is set to 40 ns, for example, that means an
individual radar pulse has a maximum time duration of 20 ns to reach a
reflector and 20 more ns to reflect back to the receiver in order to be recorded
in the data file. The bottom of the data file therefore represents a maximum
duration of 20 ns for a time window of 40 ns. The ground velocity represents
(in meters per nanosecond) how fast the radar pulses traveled through the
subsurface medium being imaged in the data file. Ground velocities range
from slow (e.g. 0.03 m/ns for fresh water) to fast (e.g. 0.3 m/ns for air) and the
user should refer to a GPR textbook or manual for the proper value related to
the media being imaged. For dry snow on the Greenland ice sheet, for
example, an average value of 0.236 m/ns may suffice if the value has not been
measured in a snow pit, based on an average dry snow density of 0.3 grams
per cubic centimeter that has been empirically related to a dry snow
permittivity of 1.62 by the following publication:
Mätzler, C. (1996), Microwave permittivity of dry snow. IEEE
Transactions on Geoscience and Remote Sensing. 34(2): 573-581.
Given an average dry snow permittivity of 1.62, an average radar velocity of
0.236 m/ns can be derived by dividing the speed of light in a vacuum (0.3
m/ns) by the square root of this permittivity.
The user may also select the sample of the "first arrival" of the radar pulse
reaching the subsurface: depth computations will start at this sample number
(y-axis). Often in GPR data, there is an obvious lack of backscatter at the top
of the file that results from the empty space that occurred between the antenna
and the surface. The first arrival begins at the point where obvious backscatter
begins. The user may also select whether or not to adjust the first arrival travel
time by the "direct wave." The direct wave is the part of the transmitted
energy that travels the shortest distance between the transmitter and receiver.
Due to antenna separation, the wave traveling from the transmitter directly to
the receiver (i.e. the direct wave) is received some time after the actual
transmission. This means that the transmitted pulse has already penetrated the
medium a certain distance before the direct wave is received. The result of this
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is that the depth scale zero must be corrected to be accurate. The zero for the
depth scale is calculated using the first arrival value, the antenna separation,
and the first arrival adjustment velocity. The adjustment velocity can be set to
any value. Practically however, it can be the ground velocity, the air velocity
(most common), or anything in between depending on the antenna
configuration.
------------------------------------------------------------------------------------TO USE IN IDL:
depth = get_gpr_depth( current_sample = current_sample, num_samples =
num_samples, time_window = time_window, ground_velocity =
ground_velocity, first_arrival = first_arrival, [ direct_wave_adjustment =
direct_wave_adjustment, adjustment_velocity = adjustment_velocity,
antenna_separation = antenna_separation ] )
Return Value:
depth (integer) = the depth in meters of the specified sample number (y-axis).
Keywords:
current_sample (integer) = the number of the sample (vertical- or ydimension) to compute the depth of, where 0 is the first sample at the
top of the file.
num_samples (integer) = total number of samples (vertical- or y- dimension)
in the GPR file.
time_window (double) = the amount of time in nanoseconds (10^-9 seconds)
that the GPR instrument was set to "listen" for radar pulses per trace at
the time of data acquisition. This value can be found in the "*.rad" file
associated with a particular RAMAC GPR data file ("*.rd3") in the
row labeled "TIMEWINDOW".
ground_velocity (float) = the velocity (in meters per nanosecond) at which
radar would travel through the imaged subsurface medium/media.
Ground velocities range from slow (e.g. 0.03 m/ns for fresh water) to
fast (e.g. 0.3 m/ns for air) and the user should refer to a GPR textbook
or manual for the proper value related to the media being imaged.
first_arrival (integer) = the number of the sample (vertical- or y-dimension) at
which the first radar pulse has reached the subsurface in the data file.
This will be the zero-depth point, without direct wave adjustment.
direct_wave_adjustment (0 = no; 1 = yes) (optional) = a flag to specify

89
whether or not to adjust the reported depth measurement by the direct
wave. If not supplied, the default is 0 (no adjustment).
adjustment_velocity (double) (optional) = the velocity (in meters per
nanosecond) at which radar would travel the direct wave. Most
frequently this will be the velocity of air (0.3 m/ns). This only needs to
be supplied if the direct_wave_adjustment is set to 1.
antenna_separation (double) (optional) = the separation in meters between the
transmitter and receiver antennae. This value can be found in the
"*.rad" file associated with a particular RAMAC GPR data file
("*.rd3") in the row labeled "ANTENNA SEPARATION". This
keyword only needs to be supplied if the direct_wave_adjustment is
set to 1.
Example:
depth = get_gpr_depth( current_sample = 212, num_samples = 1024,
time_window = 42.5, ground_velocity = 0.236, first_arrival = 0 )
[NOTE: depth should be 1.0382617 meters in the above example.]
depth = get_gpr_depth( current_sample = 212, num_samples = 1024,
time_window = 42.5, ground_velocity = 0.236, first_arrival = 100,
direct_wave_adjustment = 1, adjustment_velocity = 0.3, antenna_separation =
0.1 )
[NOTE: depth should be 0.58784896 meters in the above example.]
------------------------------------------------------------------------------------d. collect_input_get_gpr_depth.pro
This IDL function is called to collect user input related to converting time to
depth conversion settings for a Malå Geoscience RAMAC™ groundpenetrating radar (GPR) data file. In addition, this function may also collect
start and end distance settings. It displays a window for the user to enter
various parameters necessary for computing depth (and optionally distance),
which are ultimately passed to the "get_gpr_depth.pro" procedure for a given
pixel location.
------------------------------------------------------------------------------------TO USE IN IDL:
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result = collect_input_get_gpr_depth( ystart = ystart, num_samples =
num_samples, time_window = time_window, antenna_separation =
antenna_separation, [/COLLECT_DISTANCE_INFO] )
Return Value:
result.accept = 1 if user selects "OK", 0 if "Cancel".
return.ground_velocity (float) = the velocity (in meters per nanosecond) at
which radar would travel through the imaged subsurface
medium/media. Ground velocities range from slow (e.g. 0.03 m/ns for
fresh water) to fast (e.g. 0.3 m/ns for air) and the user should refer to a
GPR textbook or manual for the proper value related to the media
being imaged.
return.first_arrival (integer) = the number of the sample (vertical- or ydimension) at which the first radar pulse has reached the subsurface in
the data file. This will be the zero-depth point, without direct wave
adjustment. This first arrival is returned in image coordinates (ystart is
top pixel and num_samples is bottom pixel).
return.direct_wave_adjustment (0 = no; 1 = yes) = a flag to specify whether or
not to adjust the reported depth measurement by the direct wave.
return.adjustment_velocity (double) = the velocity (in meters per nanosecond)
at which radar would travel the direct wave. Most frequently this will
be the velocity of air (0.3 m/ns). This only needs to be supplied if the
direct_wave_adjustment is set to 1.
return.start_distance (optional) (float) = The start distance (in meters) of the
data file. Will not be supplied unless /COLLECT_DISTANCE_INFO
is set.
return.end_distance (optional) (float) = The estimated end distance (in meters)
of the data file. Will not be supplied unless
/COLLECT_DISTANCE_INFO is set.
Keywords:
ystart (integer) = the first sample (vertical- or y- dimension) in the file being
filtered (i.e. at the very top of the file). This is a zero-based number, so
unless the data have been subsetted, it is likely that ystart = 0.
num_samples (integer) = total number of samples (vertical- or y- dimension)
in the file being filtered. Used to provide a slider between the first
sample and the last sample for the user to select a first arrival sample.
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time_window (double) = the amount of time in nanoseconds (10-9 seconds)
that the GPR instrument was set to "listen" for radar pulses per trace at
the time of data acquisition. This value can be found in the "*.rad" file
associated with a particular RAMAC GPR data file ("*.rd3") in the
row labeled "TIMEWINDOW".
antenna_separation (double) = the separation in meters between the
transmitter and receiver antennae. This value can be found in the
"*.rad" file associated with a particular RAMAC GPR data file
("*.rd3") in the row labeled "ANTENNA SEPARATION". This
keyword only needs to be supplied if the direct_wave_adjustment is
set to 1.
COLLECT_DISTANCE_INFO (optional) = when this keyword is set, the
widget will ask the user for an estimated start distance and end
distance (in meters) in addition to the time-to-depth conversion
settings.
Examples:
result = collect_input_get_gpr_depth( ystart = 0, num_samples = 1024,
time_window = 42.5, antenna_separation = 0.1,
/COLLECT_DISTANCE_INFO )
result = collect_input_get_gpr_depth( ystart = 0, num_samples = 1024,
time_window = 42.5, antenna_separation = 0.1 )
------------------------------------------------------------------------------------e. get_gpr_distance.pro
This IDL function returns the distance in meters of a given trace (x-axis) in a
Malå Geoscience RAMAC™ ground-penetrating radar (GPR) data file based
on the given start and end distance of the data file provided by the user.
NOTE: A "trace" is a single, vertical column of GPR data, representing the
signal "traced" by a radar pulse as it travels from the instrument into the
subsurface. Traces are herein described to be composed of a number of
samples (vertical dimension, or y-axis), and the number of traces are used to
describe the horizontal dimension, or x-axis. Note that in ENVI-terminology,
"samples" are counted in the horizontal dimension, in contrast, and "lines" are
counted in the vertical dimension, but we use GPR-terminology here instead
to avoid confusion.
The distance of a given trace is computed according to the following equation:
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1. total_distance = end_distance - start_distance
2. depth_per_trace = total_distance / num_traces
3. current_distance = depth_per_trace * current_trace
------------------------------------------------------------------------------------TO USE IN IDL:
distance = get_gpr_distance( current_trace = current_trace, num_traces =
num_traces, start_distance = start_distance, end_distance = end_distance )
Return Value:
distance = the distance in meters of the specified trace number (x-axis).
Keywords:
current_trace = the number of the trace (horizontal- or x-dimension) to
compute the distance of, where 0 is the first trace at the left of the file.
num_traces = total number of traces (horizontal- or x- dimension) in the GPR
file.
start_distance = the distance of the first (left-most) trace in the GPR file. In
most cases, this will probably be 0 meters.
end_distance = the distance of the last (right-most) trace in the GPR file.
Example:
distance = get_gpr_distance( current_trace = 500, num_traces = 1000,
start_distance = 0, end_distance = 100 )
[NOTE: distance should be 50.0000 meters in the above example.]
------------------------------------------------------------------------------------Create XYZ File:
f. create_xyz_file.pro
NOTE: Requires the following other files:
• get_gpr_depth.pro
• collect_input_get_gpr_depth.pro
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This IDL procedure creates an XYZ file (latitude, longitude, depth) of a linear
feature identified within one or more Malå Geoscience RAMAC™ groundpenetrating radar (GPR) data files. An "XYZ file" is a text file with three
space-delimited columns: the first column (X) contains a latitude (in decimal
degrees: e.g. 78.0167778), the second column (Y) contains a longitude (also
in decimal degrees: e.g. 33.9808222), and the third column (Z) contains a
depth measurement (in negative meters: e.g. -0.661157). Such a file can be
used to create a regularly-gridded data file that can then be visualized in threedimensions. Both IDL's "iTools" and the Surfer software package
(http://goldensoftware.com) are examples of tools that can be easily used to
both grid and view the XYZ text file in three dimensions.
In order to output the XYZ file, this procedure gets the pixel locations of each
specified ENVI Region-of-Interest (ROI) file (*.roi) and uses further input
from the user (i.e. ground radar velocity, sample number [y-dimension] of first
arrival, whether to adjust for the direct wave, etc.) to compute the depth of
each of these pixel locations (using "get_gpr_depth.pro"). Each pixel location
can also be associated with an associated trace number (x-dimension) in the
RAMAC GPS coordinates file (.cor), for which the coordinates are converted
from degree:minutes:seconds format to double-precision floating-point
decimal degrees. The user is also asked for an output file location at which to
write the XYZ output to.
------------------------------------------------------------------------------------TO USE IN IDL:
create_xyz_file, gpr_files = gpr_files, roi_files = roi_files, header_file =
header_file, gps_file = gps_file
Return Value:
Does not return anything to IDL. Outputs a text file with three space-delimited
columns at a file location specified by the user before processing. The first
column (X) contains a latitude (in decimal degrees: e.g. 78.0167778), the
second column (Y) contains a longitude (also in decimal degrees: e.g.
33.9808222), and the third column (Z) contains a depth measurement (in
negative meters: e.g. -0.661157). Latitude and longitude are reported as
double-precision floating-point values with seven decimal places while depth
is reported as a single-precision floating-point value with six decimal places.
For example:
78.0167778
78.0167694
78.0167556
78.0167694
78.0167639

33.9808222
33.9808361
33.9807333
33.9808694
33.9808694

-0.695942
-0.666542
-0.681242
-0.784144
-0.784144
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Keywords:
gpr_files (string array) = The data file(s) for which to generate an XYZ file.
Each file should be specified with its full path and filename.
roi_files (string array) = The associated ENVI polyline region-of-interest
(ROI) files (*.roi) that identify a linear feature of interest within the
data files (e.g. annual snow accumulation layer, bottom of a floating
ice tongue, etc.). There must be one ROI file selected per data file.
Also, in order for "create_xyz_file.pro" to know which ROI file goes
with which data file, the ROI files must be listed in alphabetical order
in the same manner as the associated data files. Each file should be
specified with its full path and filename.
header_file (string) = The associated RAMAC header file (*.rad) so that the
two-way time window (ns), transmitter-to-receiver antenna separation
(m), and total number of traces (x-dimension) can be passed to the
depth-computing procedure (i.e. "get_gpr_depth.pro"). When
specifying multiple data files (e.g. spatial subsets/transects of an
original RAMAC *.rd3 data file), therefore, each must conform to the
same time window and antenna separation. The header file should be
specified with its full path and filename.
gps_file (string) = The RAMAC GPS coordinates file (*.cor) that contains the
latitude and longitude for every trace (x-dimension) in the original
*.rd3 RAMAC data file. RAMAC "GroundVision" software can be set
to collect GPS data in the GroundVision Standard (*.cor) format
during data acquisition. At this time, other GPS file formats are not
accepted. The GroundVision Standard format (*.cor) is a commadelimited text file with latitude and longitude in the 4th and 5th
columns respectively, where both are expressed in units of
degrees:minutes:seconds as in the following example:
78:01:00.42 NN,33:58:50.96 WW
When selecting multiple data files (e.g. spatial subsets/transects of an
original RAMAC *.rd3 data file), therefore, each must be contained by
the selected *.cor GPS coordinates file. When subsetting, therefore, it
is necessary to record the "xstart" location of every subset/transect so
that these files record their location within the original *.rd3 RAMAC
data file and can thereby find their associated GPS coordinates in the
*.cor file. The GPS file should be specified with its full path and
filename.
Examples:
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create_xyz_file, gpr_files = [ 'C:\GPR_data\GPR_data_file1.rd3' ], roi_files =
[ 'C:\GPR_data\GPR_layer1.roi' ], header_file =
'C:\GPR_data\GPR_data_file1.rad', gps_file =
'C:\GPR_data\GPR_data_file1.cor'
create_xyz_file, gpr_files = [ 'C:\GPR_data\GPR_transect1.bin',
'C:\GPR_data\GPR_transect2.bin' ], roi_files = [
'C:\GPR_data\GPR_transect1.roi', 'C:\GPR_data\GPR_transect2.roi' ],
header_file = 'C:\GPR_data\GPR_data_file1.rad', gps_file =
'C:\GPR_data\GPR_data_file1.cor'
------------------------------------------------------------------------------------------------------------------------------------------------------------------------TO USE IN ENVI:
To use this procedure within ENVI, refer to the documentation for the
following two IDL procedures:
1. collect_input_create_xyz_file.pro
2. collect_input_bulk_xyz_file.pro
The above procedures can be used to gather the necessary input and call this
procedure (i.e. "create_xyz_file.pro") on either a single file that is already
open in ENVI or on multiple files, respectively.
------------------------------------------------------------------------------------g. collect_input_create_xyz_file.pro
NOTE: Requires the following other files:
• create_xyz_file.pro
• get_gpr_depth.pro
• collect_input_get_gpr_depth.pro
This IDL procedure can be run in ENVI to collect the necessary input
parameters for and then call the associated "create_xyz_file.pro" IDL
procedure for creating an XYZ file (latitude, longitude, depth) of a layer
identified within a Malå Geoscience RAMAC™ ground-penetrating radar
(GPR) data file. An "XYZ file" is a text file with three space-delimited
columns: the first column (X) contains a latitude (in decimal degrees: e.g.
78.0167778), the second column (Y) contains a longitude (also in decimal
degrees: e.g. 33.9808222), and the third column (Z) contains a depth
measurement (in negative meters: e.g. -0.661157). Such a file can be used to
create a regularly-gridded data file that can then be visualized in threedimensions. Both IDL's "iTools" and Surfer software
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(http://goldensoftware.com) are examples of tools that can be easily used to
both grid and view the XYZ text file in three dimensions.
In order to produce such an XYZ file, the "create_xyz_file.pro" procedure
needs to know the following input parameters:
1. The data file (i.e. the currently viewed GPR data file).
2. The associated ENVI polyline region-of-interest (ROI) file (*.roi) that
identifies a linear feature of interest within the data file (e.g. annual snow
accumulation layer, bottom of a floating ice tongue, etc.).
3. The associated RAMAC header file (*.rad) so that the two-way time
window (ns), transmitter-to-receiver antenna separation (m), and total
number of traces (x-dimension) can be passed to the depth-computing
procedure (i.e. "get_gpr_depth.pro") called within "create_xyz_file.pro".
4. The RAMAC GPS coordinates file (*.cor) that contains the latitude and
longitude for every trace (x-dimension) in the data file. RAMAC
"GroundVision" software can be set to collect GPS data in the
GroundVision Standard (*.cor) format during data acquisition. At this
time, other GPS file formats are not acceptable. The GroundVision
Standard format (*.cor) is a comma-delimited text file with latitude and
longitude in the 4th and 5th columns respectively, where both are
expressed in units of degrees:minutes:seconds as in the following
example:
78:01:00.42 NN,33:58:50.96 WW
The above parameters are collected by this procedure and then passed to
"create_xyz_file.pro" to generate an XYZ file at a user-specified file location.
------------------------------------------------------------------------------------TO USE IN ENVI: After saving this procedure in the ENVI "save_add"
directory, add the following lines to ENVI's function menu configuration file
(display.men) located in ENVI's "menu" directory:
0 {GPR}
1 {Create XYZ File...} {not used} {collect_input_create_xyz_file}
This procedure can then be run from the pull-down menu labeled "GPR" on a
GPR file that you have already opened in ENVI.
------------------------------------------------------------------------------------h. collect_input_bulk_xyz_file.pro
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NOTE: Requires the following other files:
• create_xyz_file.pro
• get_gpr_depth.pro
• collect_input_get_gpr_depth.pro
This IDL procedure can be run in ENVI to collect the necessary input
parameters for and then call the associated "create_xyz_file.pro" IDL
procedure for creating an XYZ file (latitude, longitude, depth) of a layer
identified within one or more Malå Geoscience RAMAC™ ground-penetrating
radar (GPR) data files. An "XYZ file" is a text file with three space-delimited
columns: the first column (X) contains a latitude (in decimal degrees: e.g.
78.0167778), the second column (Y) contains a longitude (also in decimal
degrees: e.g. 33.9808222), and the third column (Z) contains a depth
measurement (in negative meters: e.g. -0.661157). Such a file can be used to
create a regularly-gridded data file that can then be visualized in threedimensions. Both IDL's "iTools" and Surfer software
(http://goldensoftware.com) are examples of tools that can be easily used to
both grid and view the XYZ text file in three dimensions.
In order to produce such an XYZ file, the "create_xyz_file.pro" procedure
needs to know the following input parameters:
1. The data file(s) for which to generate an XYZ file.
2. The associated ENVI polyline region-of-interest (ROI) files (*.roi) that
identify a linear feature of interest within the data files (e.g. annual snow
accumulation layer, bottom of a floating ice tongue, etc.). There must be
one ROI file selected per data file. Also, in order for the
"create_xyz_file.pro" to know which ROI file goes with which data file,
the ROI files must be listed in alphabetical order in the same manner as
the associated data files.
3. The associated RAMAC header file (*.rad) so that the two-way time
window (ns), transmitter-to-receiver antenna separation (m), and total
number of traces (x-dimension) can be passed to the depth-computing
procedure (i.e. "get_gpr_depth.pro") called within "create_xyz_file.pro".
When selecting multiple data files (e.g. spatial subsets/transects of an
original RAMAC *.rd3 data file), therefore, each must conform to the
same time window and antenna separation.
4. The RAMAC GPS coordinates file (*.cor) that contains the latitude and
longitude for every trace (x-dimension) in the original *.rd3 RAMAC
data file. RAMAC "GroundVision" software can be set to collect GPS
data in the GroundVision Standard (*.cor) format during data acquisition.
At this time, other GPS file formats are not acceptable. The GroundVision
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Standard format (*.cor) is a comma-delimited text file with latitude and
longitude in the 4th and 5th columns respectively, where both are
expressed in units of degrees:minutes:seconds as in the following
example:
78:01:00.42 NN,33:58:50.96 WW
When selecting multiple data files (e.g. spatial subsets/transects of an
original RAMAC *.rd3 data file), therefore, each must be contained by
the selected *.cor GPS coordinates file. When subsetting, therefore, it is
necessary to record the xstart of every subset/transect so that these files
record their location within the original *.rd3 RAMAC data file and can
find their associated GPS coordinates in the *.cor file.
The above parameters are collected by this procedure and then passed to
"create_xyz_file.pro" to generate an XYZ file at a user-specified file location.
------------------------------------------------------------------------------------TO USE IN ENVI: After saving this procedure in the ENVI "save_add"
directory, add the following lines to ENVI's main menu configuration file
(envi.men) located in ENVI's "menu" directory:
0 {GPR}
1 {Create XYZ File} {not used} {collect_input_bulk_xyz_file}
This procedure can then be run from the pull-down menu labeled "GPR" on
ENVI's main menu bar.
------------------------------------------------------------------------------------Compute Depth Statistics:
i. compute_depth_statistics.pro
NOTE: Requires the following other files:
• get_gpr_depth.pro
• collect_input_get_gpr_depth.pro
This IDL procedure computes statistics for the depth of a linear feature within
a Malå Geoscience RAMAC™ ground-penetrating radar (GPR) data file or
files. This linear feature (e.g. annual snow accumulation layer, bottom of a
floating ice tongue, etc.) should be previously digitized in an ENVI polyline
region-of-interest (ROI) file (*.roi) or files. The statistics reported are the
mean, max, and min depths (in meters) and the standard deviation of the depth
(in meters). In addition, these depth statistics can also be expressed in terms of
snow water equivalent (SWE) if the subsurface in the GPR data is snow/ice.
In order to accomplish this, the user is presented with a window to input the
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average density of the subsurface (in grams per cubic centimeter). The SWE is
then returned in grams per squared centimeter; this can be converted by the
end-user to units of millimeters simply by dividing by the density of water (1
g/cm3) and multiplying by 10.
In order to output these statistics, this procedure gets the pixel locations of
each specified ROI file and uses further input from the user (i.e. ground radar
velocity, sample number [y-dimension] of first arrival, whether to adjust for
the direct wave, etc.) to compute the depth of each of these pixel locations
(using "get_gpr_depth.pro").
------------------------------------------------------------------------------------TO USE IN IDL:
statistics = compute_depth_statistics( gpr_files = gpr_files, roi_files =
roi_files, header_file = header_file )
Return Value:
statistics.total_measurements (integer) = The total number of pixel addresses
in the polyline region-of-interest (ROI) used in the depth/SWE
statistics reported below. Note that this may be greater than the
number of pixels in the x-dimension in the corresponding data file(s)
since the polyline may include multiple samples (y-dimension) at a
particular trace (x-dimension).
statistics.mean_depth_meters (float) = The mean depth in meters of the
selected linear feature.
statistics.stddev_depth_meters (float) = The standard deviation in meters of
the selected linear feature.
statistics.min_depth_meters (float) = The minimum depth in meters of the
selected linear feature.
statistics.max_depth_meters (float) = The maximum depth in meters of the
selected linear feature.
statistics.mean_swe_gcm2 (float or NaN) = The mean snow water equivalent
(SWE) in units of grams per squared centimeter (g/cm2) of the selected
linear feature. If the user did not provide a subsurface density because
SWE is irrelevant to the subsurface being measured, this value will be
an invalid value (IDL's "NaN", for "not a number").
statistics.stddev_swe_gcm2 (float or NaN) = The standard deviation of SWE
in units of grams per squared centimeter (g/cm2) of the selected linear
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feature. If the user did not provide a subsurface density because SWE
is irrelevant to the subsurface being measured, this value will be an
invalid value (IDL's "NaN", for "not a number").
statistics.min_swe_gcm2 (float or NaN) = The minimum SWE in units of
grams per squared centimeter (g/cm2) of the selected linear feature. If
the user did not provide a subsurface density because SWE is
irrelevant to the subsurface being measured, this value will be an
invalid value (IDL's "NaN", for "not a number").
statistics.max_swe_gcm2 (float or NaN) = The maximum SWE in units of
grams per squared centimeter (g/(cm2) of the selected linear feature. If
the user did not provide a subsurface density because SWE is
irrelevant to the subsurface being measured, this value will be an
invalid value (IDL's "NaN", for "not a number").
Keywords:
gpr_files (string array) = The data file(s) for which to generate an XYZ file.
Each file should be specified with its full path and filename.
roi_files (string array) = The associated ENVI polyline region-of-interest
(ROI) files (*.roi) that identify a linear feature of interest within the
data files (e.g. annual snow accumulation layer, bottom of a floating
ice tongue, etc.). There must be one ROI file selected per data file.
Also, in order for the "create_xyz_file.pro" to know which ROI file
goes with which data file, the ROI files must be listed in alphabetical
order in the same manner as the associated data files. Each file should
be specified with its full path and filename.
header_file (string) = The associated RAMAC header file (*.rad) so that the
two-way time window (ns), transmitter-to-receiver antenna separation
(m), and total number of traces (x-dimension) can be passed to the
depth-computing procedure (i.e. "get_gpr_depth.pro"). When
specifying multiple data files (e.g. spatial subsets/transects of an
original RAMAC *.rd3 data file), therefore, each must conform to the
same time window and antenna separation. The header file should be
specified with its full path and filename.
Examples:
statistics = compute_depth_statistics( gpr_files = [
'C:\GPR_data\GPR_data_file1.rd3' ], roi_files = [
'C:\GPR_data\GPR_layer1.roi' ], header_file =
'C:\GPR_data\GPR_data_file1.rad' )
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statistics = compute_depth_statistics( gpr_files = [
'C:\GPR_data\GPR_transect1.bin', 'C:\GPR_data\GPR_transect2.bin' ],
roi_files = [ 'C:\GPR_data\GPR_transect1.roi',
'C:\GPR_data\GPR_transect2.roi' ], header_file =
'C:\GPR_data\GPR_data_file1.rad' )
------------------------------------------------------------------------------------------------------------------------------------------------------------------------TO USE IN ENVI:
To use this procedure within ENVI, refer to the documentation for the
following two IDL procedures:
1. collect_input_compute_depth_statistics.pro
2. collect_input_bulk_depth_statistics.pro
The above procedures can be used to gather the necessary input and call this
procedure (i.e. "compute_depth_statistics.pro") on either a single file that is
already open in ENVI or on multiple files, respectively.
------------------------------------------------------------------------------------j. collect_input_compute_depth_statistics.pro
NOTE: Requires the following other files:
• compute_depth_statistics.pro
• get_gpr_depth.pro
• collect_input_get_gpr_depth.pro
This IDL procedure can be run in ENVI to collect the necessary input
parameters for and then call the associated "compute_depth_statistics.pro"
IDL procedure for computing depth statistics of a linear feature identified
within a Malå Geoscience RAMAC™ ground-penetrating radar (GPR) data
file. The computed statistics are displayed in a widget window for the user to
view. Please see the documentation for "compute_depth_statistics.pro" for
further details on the statistics that get generated.
In order to produce such statistics, the "compute_depth_statistics.pro"
procedure needs to know the following input parameters:
1. The data file (i.e. the currently viewed GPR data file).
2. The associated ENVI polyline region-of-interest (ROI) file (*.roi) that
identifies a linear feature of interest within the data file (e.g. annual snow
accumulation layer, bottom of a floating ice tongue, etc.).
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3. The associated RAMAC header file (*.rad) so that the two-way time
window (ns), transmitter-to-receiver antenna separation (m), and total
number of traces (x-dimension) can be passed to the depth-computing
procedure (i.e. "get_gpr_depth.pro") called within
"compute_depth_statistics.pro".
The above parameters are collected by this procedure and then passed to
"compute_depth_statistics.pro" to generate the statistics and display the
results to the user.
------------------------------------------------------------------------------------TO USE IN ENVI: After saving this procedure in the ENVI "save_add"
directory, add the following lines to ENVI's function menu configuration file
(display.men) located in ENVI's "menu" directory:
0 {GPR}
1 {Compute Depth Statistics...} {not used}
{collect_input_compute_depth_statistics}
This procedure can then be run from the pull-down menu labeled "GPR" on a
GPR file that you have already opened in ENVI.
------------------------------------------------------------------------------------k. collect_input_bulk_depth_statistics.pro
NOTE: Requires the following other files:
• compute_depth_statistics.pro
• get_gpr_depth.pro
• collect_input_get_gpr_depth.pro
This IDL procedure can be run in ENVI to collect the necessary input
parameters for and then call the associated "compute_depth_statistics.pro"
IDL procedure for computing depth statistics of a linear feature identified
within one or more Malå Geoscience RAMAC™ ground-penetrating radar
(GPR) data files. The computed statistics are displayed in a widget window
for the user to view. Please see the documentation for
"compute_depth_statistics.pro" for further details on the statistics that get
generated.
In order to produce such statistics, the "compute_depth_statistics.pro"
procedure needs to know the following input parameters:
1. The data file(s) for which to generate an XYZ file.
2. The associated ENVI polyline region-of-interest (ROI) files (*.roi) that
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identify a linear feature of interest within the data files (e.g. annual snow
accumulation layer, bottom of a floating ice tongue, etc.). There must be
one ROI file selected per data file. Also, in order for the
"compute_depth_statistics.pro" to know which ROI file goes with which
data file, the ROI files must be listed in alphabetical order in the same
manner as the associated data files.
3. The associated RAMAC header file (*.rad) so that the two-way time
window (ns), transmitter-to-receiver antenna separation (m), and total
number of traces (x-dimension) can be passed to the depth-computing
procedure (i.e. "get_gpr_depth.pro") called within
"compute_depth_statistics.pro". When selecting multiple data files (e.g.
spatial subsets/transects of an original RAMAC *.rd3 data file), therefore,
each must conform to the same time window and antenna separation.
The above parameters are collected by this procedure and then passed to
"compute_depth_statistics.pro" to generate the statistics and display the
results to the user.
------------------------------------------------------------------------------------TO USE IN ENVI: After saving this procedure in the ENVI "save_add"
directory, add the following lines to ENVI's main menu configuration file
(envi.men) located in ENVI's "menu" directory:
0 {GPR}
1 {Compute Depth Statistics} {not used}
{collect_input_bulk_depth_statistics}
This procedure can then be run from the pull-down menu labeled "GPR" on
ENVI's main menu bar.
-------------------------------------------------------------------------------------

